Oracle Solaris Trusted Extensions User's Guide
This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject to the restrictions and license terms set forth in the applicable Government contract, and, to the extent applicable by the terms of the Government contract, the additional rights set forth in FAR 52.227-19, Commercial Computer Software License (December 2007). Oracle America, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications which may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro Devices. Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. UNIX is a registered trademark licensed through X/Open Company, Ltd.

This software or hardware and documentation may provide access to or information on content, products, and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services.

Copyright © 1997, 2010, Oracle and/or its affiliates. All rights reserved.

This software and related documentation are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject to the restrictions and license terms set forth in the applicable Government contract, and, to the extent applicable by the terms of the Government contract, the additional rights set forth in FAR 52.227-19, Commercial Computer Software License (December 2007). Oracle America, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications which may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro Devices. Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. UNIX is a registered trademark licensed through X/Open Company, Ltd.

Copyright © 1997, 2010, Oracle and/or its affiliates. All rights reserved.

This software and related documentation are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject to the restrictions and license terms set forth in the applicable Government contract, and, to the extent applicable by the terms of the Government contract, the additional rights set forth in FAR 52.227-19, Commercial Computer Software License (December 2007). Oracle America, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications which may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro Devices. Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. UNIX is a registered trademark licensed through X/Open Company, Ltd.

Copyright © 1997, 2010, Oracle and/or its affiliates. All rights reserved.

This software and related documentation are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject to the restrictions and license terms set forth in the applicable Government contract, and, to the extent applicable by the terms of the Government contract, the additional rights set forth in FAR 52.227-19, Commercial Computer Software License (December 2007). Oracle America, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications which may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro Devices. Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. UNIX is a registered trademark licensed through X/Open Company, Ltd.

Copyright © 1997, 2010, Oracle and/or its affiliates. All rights reserved.
Contents

Preface ...................................................................................................................................................11

1 Introduction to Solaris Trusted Extensions Software ................................................................. 15
    What Is Trusted Extensions Software? ......................................................................................... 15
    Trusted Extensions Protects Against Intruders .......................................................................... 16
    Access to the Trusted Computing Base Is Limited ...................................................................... 16
    Mandatory Access Control Protects Information ....................................................................... 17
    Peripheral Devices Are Protected ................................................................................................ 17
    Programs That Spoof Users Are Prevented .................................................................................. 17
    Trusted Extensions Provides Discretionary and Mandatory Access Control ............................ 18
        Discretionary Access Control .................................................................................................. 18
        Mandatory Access Control ..................................................................................................... 18
        User Responsibilities for Protecting Data ............................................................................... 24
    Trusted Extensions Separates Information by Label .................................................................. 25
        Single-Level or Multilevel Sessions .......................................................................................... 25
        Session Selection Example ..................................................................................................... 25
        Labeled Workspaces ................................................................................................................ 26
        Enforcing MAC for Email Transactions .................................................................................. 27
        Erasing Data on Objects Prior to Object Reuse ...................................................................... 27
    Trusted Extensions Enables Secure Administration .................................................................... 27
        Accessing Applications in Trusted Extensions ......................................................................... 28
        Administration by Role in Trusted Extensions ......................................................................... 29

2 Logging In to Trusted Extensions (Tasks) .................................................................................... 31
    Desktops and Login in Trusted Extensions .................................................................................. 31
    Trusted Extensions Login Process ................................................................................................ 32
        Desktop Choice Before Login ................................................................................................. 32
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identification and Authentication During Login</td>
<td>33</td>
</tr>
<tr>
<td>Review Security Attributes During Login</td>
<td>33</td>
</tr>
<tr>
<td>Logging In to Trusted Extensions</td>
<td>33</td>
</tr>
<tr>
<td>▼ Choose a Trusted Desktop</td>
<td>33</td>
</tr>
<tr>
<td>▼ Identify and Authenticate Yourself to the System</td>
<td>34</td>
</tr>
<tr>
<td>▼ Check Messages and Select Session Type</td>
<td>34</td>
</tr>
<tr>
<td>▼ Troubleshoot Login Problems</td>
<td>37</td>
</tr>
<tr>
<td>Logging In Remotely to Trusted Extensions</td>
<td>37</td>
</tr>
<tr>
<td>▼ How to Log In to a Remote Trusted Extensions Desktop</td>
<td>37</td>
</tr>
<tr>
<td>3 Working in Trusted Extensions (Tasks)</td>
<td>39</td>
</tr>
<tr>
<td>Visible Desktop Security in Trusted Extensions</td>
<td>39</td>
</tr>
<tr>
<td>Trusted Extensions Logout Process</td>
<td>40</td>
</tr>
<tr>
<td>Working on a Labeled System</td>
<td>40</td>
</tr>
<tr>
<td>▼ How to Lock and Unlock Your Screen</td>
<td>40</td>
</tr>
<tr>
<td>▼ How to Log Out of Trusted Extensions</td>
<td>42</td>
</tr>
<tr>
<td>▼ How to Shut Down Your System</td>
<td>43</td>
</tr>
<tr>
<td>▼ How to View Your Files in a Labeled Workspace</td>
<td>44</td>
</tr>
<tr>
<td>▼ How to Access the Trusted Extensions Man Pages</td>
<td>45</td>
</tr>
<tr>
<td>▼ How to Access Trusted Extensions Online Help</td>
<td>45</td>
</tr>
<tr>
<td>▼ How to Customize the CDE Workspace Menu</td>
<td>46</td>
</tr>
<tr>
<td>▼ How to Access Initialization Files at Every Label</td>
<td>47</td>
</tr>
<tr>
<td>▼ How to Interactively Display a Window Label</td>
<td>49</td>
</tr>
<tr>
<td>▼ How to Perform Some Common Desktop Tasks in Trusted Extensions</td>
<td>50</td>
</tr>
<tr>
<td>Performing Trusted Actions</td>
<td>51</td>
</tr>
<tr>
<td>▼ How to Change Your Password in Trusted Extensions</td>
<td>51</td>
</tr>
<tr>
<td>▼ How to Log In at a Different Label</td>
<td>52</td>
</tr>
<tr>
<td>▼ How to Allocate a Device in Trusted Extensions</td>
<td>53</td>
</tr>
<tr>
<td>▼ How to Deallocate a Device in Trusted Extensions</td>
<td>57</td>
</tr>
<tr>
<td>▼ How to Assume a Role in Trusted Extensions</td>
<td>57</td>
</tr>
<tr>
<td>▼ How to Change the Label of a Workspace</td>
<td>58</td>
</tr>
<tr>
<td>▼ How to Add a Workspace at a Particular Label</td>
<td>58</td>
</tr>
<tr>
<td>▼ How to Switch to a Workspace at a Different Label</td>
<td>59</td>
</tr>
<tr>
<td>▼ How to Move a Window to a Different Workspace</td>
<td>60</td>
</tr>
<tr>
<td>▼ How to Determine the Label of a File</td>
<td>61</td>
</tr>
</tbody>
</table>
Figures

FIGURE 1–1  Trusted Extensions Logo in CDE ................................................................. 16
FIGURE 1–2  Trusted Symbol .......................................................................................... 17
FIGURE 1–3  Typical Industry Sensitivity Labels .......................................................... 19
FIGURE 1–4  Typical Trusted CDE Session ................................................................. 20
FIGURE 1–5  Typical Trusted JDS Session ................................................................. 21
FIGURE 1–6  Viewing Public Information From a Higher-Label Zone ......................... 22
FIGURE 1–7  Workspace Switch Area .......................................................................... 26
FIGURE 1–8  Labeled Panels ...................................................................................... 27
FIGURE 2–1  Last Login Dialog Box ........................................................................... 35
FIGURE 2–2  Label Builder .......................................................................................... 36
FIGURE 3–1  Front Panel Switch Area ........................................................................ 41
FIGURE 3–2  Lock Screen Selection ........................................................................... 41
FIGURE 3–3  A Labeled File Manager ........................................................................ 44
FIGURE 3–4  Trusted Extensions Online Help .............................................................. 46
FIGURE 3–5  Query Window Label Operation ............................................................. 49
FIGURE 3–6  Trusted Path Menu ................................................................................ 52
FIGURE 3–7  Device Allocation Icon in Trusted CDE .................................................. 53
FIGURE 3–8  Device Allocation Manager ................................................................... 54
FIGURE 3–9  Instructions for Microphone Use ............................................................ 55
FIGURE 3–10 Front Panel With Switches at Different Labels ...................................... 59
FIGURE 3–11 Occupy Workspace Menu in Trusted CDE ........................................... 60
FIGURE 3–12 Differently Labeled Windows in One Workspace .................................. 61
FIGURE 3–13 Differently Labeled Applications in One Workspace ......................... 62
FIGURE 3–14 Selection Manager Confirmation Dialog Box in Trusted JDS ............... 63
FIGURE 3–15 Selection Manager Confirmation Dialog Box in Trusted CDE ............. 64
FIGURE 3–16 Differently Labeled File Managers in One Workspace ....................... 66
FIGURE 3–17 Dragging a File Between File Managers at Different Labels ............... 67
FIGURE 3–18 File Manager Confirmation Dialog Box ............................................... 68
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-1</td>
<td>Multilevel Trusted CDE Desktop</td>
<td>70</td>
</tr>
<tr>
<td>4-2</td>
<td>Panels Indicating Workspaces at Different Labels in Trusted JDS</td>
<td>71</td>
</tr>
<tr>
<td>4-3</td>
<td>PUBLIC Window Label in the Trusted Stripe</td>
<td>71</td>
</tr>
<tr>
<td>4-4</td>
<td>Trusted Stripe on the Trusted JDS Desktop</td>
<td>72</td>
</tr>
<tr>
<td>4-5</td>
<td>Trusted Path Indicator in the Trusted Stripe</td>
<td>73</td>
</tr>
<tr>
<td>4-6</td>
<td>Trusted Path Menu – Basic</td>
<td>76</td>
</tr>
<tr>
<td>4-7</td>
<td>Trusted Path Menu – Workspace Name Version</td>
<td>76</td>
</tr>
<tr>
<td>4-8</td>
<td>Typical Banner Page of a Labeled Print Job</td>
<td>78</td>
</tr>
</tbody>
</table>
Tables

<table>
<thead>
<tr>
<th>TABLE 1–1</th>
<th>Examples of Label Relationships in Trusted Extensions ........................................ 24</th>
</tr>
</thead>
<tbody>
<tr>
<td>TABLE 1–2</td>
<td>Effect of Initial Label Selection on Available Session Labels ........................................ 26</td>
</tr>
</tbody>
</table>
Preface

The Oracle Solaris Trusted Extensions User's Guide is a guide to working in the Solaris Operating System (Solaris OS) with Solaris Trusted Extensions installed.

Who Should Use This Guide

This guide is for all users of Trusted Extensions. As a prerequisite, you must be familiar with the Solaris OS and one of the following desktops:

- Common Desktop Environment (CDE)
- The open source GNOME desktop
- Sun Java Desktop System

You must also be familiar with the security policy of your organization.

How the Solaris Trusted Extensions Guides Are Organized

The following table lists the topics that are covered in the Solaris Trusted Extensions guides and the audience for each guide.

<table>
<thead>
<tr>
<th>Title of Guide</th>
<th>Topics</th>
<th>Audience</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solaris Trusted Extensions Transition Guide</td>
<td>Obsolete. Provides an overview of the differences between Trusted Solaris 8 software, Solaris 10 software, and Solaris Trusted Extensions software. For this release, the What's New document for the Solaris OS provides an overview of Trusted Extensions changes.</td>
<td>All</td>
</tr>
<tr>
<td>Solaris Trusted Extensions Reference Manual</td>
<td>Obsolete. Provides Solaris Trusted Extensions man pages for the Solaris 10 11/06 and Solaris 10 8/07 releases of Trusted Extensions. For this release, Trusted Extensions man pages are included with the Solaris man pages.</td>
<td>All</td>
</tr>
</tbody>
</table>
How This Guide Is Organized

Chapter 1, "Introduction to Solaris Trusted Extensions Software," describes the basic concepts that are implemented on a Solaris system that is configured with Trusted Extensions.

Chapter 2, "Logging In to Trusted Extensions (Tasks)," presents procedures for accessing a system and for leaving a system that is configured with Trusted Extensions.

Chapter 3, "Working in Trusted Extensions (Tasks)," describes how to use Trusted Extensions to perform your job.

Chapter 4, "Elements of Trusted Extensions (Reference)," explains the key elements in a system that is configured with Trusted Extensions.

Glossary describes security terms that are used in Trusted Extensions.
## Documentation, Support, and Training

See the following websites for additional resources:

- Documentation ([http://docs.sun.com](http://docs.sun.com))
- Training ([http://education.oracle.com](http://education.oracle.com)) – Click the Sun link in the left navigation bar.

## Oracle Welcomes Your Comments

Oracle welcomes your comments and suggestions on the quality and usefulness of its documentation. If you find any errors or have any other suggestions for improvement, go to [http://docs.sun.com](http://docs.sun.com) and click Feedback. Indicate the title and part number of the documentation along with the chapter, section, and page number, if available. Please let us know if you want a reply.

Oracle Technology Network ([http://www.oracle.com/technetwork/index.html](http://www.oracle.com/technetwork/index.html)) offers a range of resources related to Oracle software:

- Discuss technical problems and solutions on the Discussion Forums ([http://forums.oracle.com](http://forums.oracle.com)).

## Typographic Conventions

The following table describes the typographic conventions that are used in this book.

<table>
<thead>
<tr>
<th>Typeface</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>AaBbCc123</td>
<td>The names of commands, files, and directories, and onscreen computer output</td>
<td>Edit your <code>.login</code> file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use <code>ls -a</code> to list all files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>machine_name%</code> you have mail.</td>
</tr>
<tr>
<td>AaBbCc123</td>
<td>What you type, contrasted with onscreen computer output</td>
<td><code>machine_name% su</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>Password:</code></td>
</tr>
<tr>
<td>aabbcc123</td>
<td>Placeholder: replace with a real name or value</td>
<td>The command to remove a file is <code>rm filename</code>.</td>
</tr>
</tbody>
</table>
TABLE P-1  Typographic Conventions  (Continued)

<table>
<thead>
<tr>
<th>Typeface</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>AaBbCc123</td>
<td>Book titles, new terms, and terms to be emphasized</td>
<td>Read Chapter 6 in the <em>User’s Guide</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>A cache</em> is a copy that is stored locally.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Do not save the file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Some emphasized items appear bold online.</td>
</tr>
</tbody>
</table>

Shell Prompts in Command Examples

The following table shows the default UNIX system prompt and superuser prompt for shells that are included in the Oracle Solaris OS. Note that the default system prompt that is displayed in command examples varies, depending on the Oracle Solaris release.

TABLE P-2  Shell Prompts

<table>
<thead>
<tr>
<th>Shell</th>
<th>Prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bash shell, Korn shell, and Bourne shell</td>
<td>$</td>
</tr>
<tr>
<td>Bash shell, Korn shell, and Bourne shell for superuser</td>
<td>#</td>
</tr>
<tr>
<td>C shell</td>
<td><code>machine_name%</code></td>
</tr>
<tr>
<td>C shell for superuser</td>
<td><code>machine_name#</code></td>
</tr>
</tbody>
</table>
Introduction to Solaris Trusted Extensions Software

This chapter introduces you to the labelsf and other security features that Trusted Extensions software adds to the Solaris Operating System (Solaris OS).

- “What Is Trusted Extensions Software?” on page 15
- “Trusted Extensions Protects Against Intruders” on page 16
- “Trusted Extensions Provides Discretionary and Mandatory Access Control” on page 18
- “Trusted Extensions Separates Information by Label” on page 25
- “Trusted Extensions Enables Secure Administration” on page 27

What Is Trusted Extensions Software?

As the name and following logo indicate, Trusted Extensions extends the capabilities of the Solaris OS.
Trusted Extensions provides special security features for your system. These features enable an organization to define and implement a security policy on a Solaris system. A security policy is the set of rules and practices that help protect information and other resources, such as computer hardware, at your site. Typically, security rules handle such issues as who has access to which information or who is allowed to write data to removable media. Security practices are recommended procedures for performing tasks.

The following sections describe some major security features that Trusted Extensions provides. The text indicates which security features are configurable.

**Trusted Extensions Protects Against Intruders**

Trusted Extensions software adds features to the Solaris OS that protect against intruders. Trusted Extensions also relies on some Solaris features, such as password protection. Trusted Extensions adds a password change GUI for roles. Auditing is enabled by default.

**Access to the Trusted Computing Base Is Limited**

The term trusted computing base (TCB) refers to the part of the Trusted Extensions software that handles events that are relevant to security. The TCB includes software, hardware, firmware, documentation, and administrative procedures. Utilities and application programs that can access security-related files are all part of the TCB. Your administrator sets limits on all potential interactions that you can have with the TCB. Such interactions include programs that you need to perform your job, files that you are allowed to access, and utilities that can affect security.
Mandatory Access Control Protects Information

If an intruder manages to successfully log in to the system, further obstacles prevent access to information. Files and other resources are protected by access control. As in the Solaris OS, access control can be set by the owner of the information. In Trusted Extensions, access is also controlled by the system. For details, see "Trusted Extensions Provides Discretionary and Mandatory Access Control" on page 18.

Peripheral Devices Are Protected

In Trusted Extensions, administrators control access to local peripheral devices such as tape drives, CD-ROM drives, printers, and microphones. Access can be granted on a user-by-user basis. The software restricts access to peripheral devices as follows:

- By default, devices must be allocated for use.
- You must be authorized to access devices that control removable media.
- Remote users cannot use local devices such as microphones or CD-ROM drives. Only local users can allocate a device.

Programs That Spoof Users Are Prevented

To "spoof" means to imitate. Intruders sometimes spoof login or other legitimate programs to intercept passwords or other sensitive data. Trusted Extensions protects you from hostile spoofing programs by displaying the following trusted symbol, a clearly recognizable, tamper-proof icon at the bottom of the screen.

This symbol is displayed whenever you interact with the trusted computing base (TCB). The presence of the symbol ensures the safety of performing security-related transactions. No visible symbol indicates a potential security breach. The following figure shows the trusted symbol.
Trusted Extensions Provides Discretionary and Mandatory Access Control

Trusted Extensions controls which users can access which information by providing both discretionary and mandatory access control.

Discretionary Access Control

Discretionary access control (DAC) is a software mechanism for controlling user access to files and directories. DAC leaves setting protections for files and directories to the owner’s discretion. The two forms of DAC are UNIX permission bits and access control lists (ACLs).

Permission bits let the owner set read, write, and execute protection by owner, group, and other users. In traditional UNIX systems, the superuser or root user can override DAC protection. With Trusted Extensions software, the ability to override DAC is permitted for administrators and authorized users only. ACLs provide a finer granularity of access control. ACLs enable owners to specify separate permissions for specific users and specific groups. For more information, see Chapter 6, “Controlling Access to Files (Tasks),” in System Administration Guide: Security Services.

Mandatory Access Control

Mandatory access control (MAC) is a system-enforced access control mechanism that is based on label relationships. The system associates a sensitivity label with all processes that are created to execute programs. MAC policy uses this label in access control decisions. In general, processes cannot store information or communicate with other processes, unless the label of the destination is equal to the label of the process. MAC policy permits processes to read data from objects at the same label or from objects at a lower label. However, the administrator can create a labeled environment in which few lower-level objects or no lower-level objects are available.

By default, MAC policy is invisible to you. Regular users cannot see objects unless they have MAC access to those objects. In all cases, users cannot take any action that is contrary to MAC policy.

Sensitivity Labels and Clearances

A label has the following two components:

- Classification, also referred to as a level

  This component indicates a hierarchical level of security. When applied to people, the classification represents a measure of trust. When applied to data, a classification is the degree of protection that is required.
In the U.S. Government, the classifications are TOP SECRET, SECRET, CONFIDENTIAL, and UNCLASSIFIED. Industry classifications are not as standardized. Unique classifications can be established by a company. For an example, see Figure 1–3. The terms on the left are classifications. The terms on the right are compartments.

- Compartments, also referred to as categories

  A compartment represents a grouping, such as a work group, department, project, or topic. A classification does not have to have a compartment. In Figure 1–3, the Confidential classification has three exclusive compartments. Public and Max Label have no compartments. As the figure shows, five labels are defined by this organization.

![Figure 1–3 Typical Industry Sensitivity Labels](image)

Trusted Extensions maintains two types of labels: sensitivity labels and clearances. A user can be cleared to work at one or more sensitivity labels. A special label, known as the user clearance, determines the highest label at which a user is permitted to work. In addition, each user has a minimum sensitivity label. This label is used by default during login to a multilevel desktop session. After login, the user can choose to work at other labels within this range. A user could be assigned Public as the minimum sensitivity label and Confidential: Need to Know as the clearance. At first login, the desktop workspaces are at the label Public. During the session, the user can create workspaces at Confidential: Internal Use Only and Confidential: Need to Know.

All subjects and objects have labels on a system that is configured with Trusted Extensions. A subject is an active entity, usually a process. The process causes information to flow among objects or changes the system state. An object is a passive entity that contains or receives data, such as a data file, directory, printer, or other device. In some cases, a process can be an object, such as when you use the kill command on a process.

Labels can be displayed in window title bars and in the trusted stripe, which is a special stripe on the screen. Figure 1–4 shows a typical multilevel Trusted Extensions session in Trusted CDE. The labels and trusted stripe are indicated.
Figure 1–5 shows a typical multilevel Trusted Extensions session on a Trusted JDS system. The trusted stripe is at the top. The Trusted Path menu is invoked from the trusted stripe. To assume a role, click the user name to invoke the roles menu. The workspace switches in the bottom panel display the color of the workspace label. The window list in the bottom panel displays the color of the window’s label.
Containers and Labels

Trusted Extensions uses containers for labeling. Containers are also called zones. The global zone is an administrative zone, and is not available to users. Non-global zones are called labeled zones. Labeled zones are used by users. The global zone shares some system files with users. When these files are visible in a labeled zone, the label of these files is ADMIN_LOW.

Network communication is restricted by label. By default, zones cannot communicate with each other because their labels are different. Therefore, one zone cannot write into another zone.
However, the administrator can configure specific zones to be able to read specific directories from other zones. The other zones could be on the same host, or on a remote system. For example, a user's home directory in a lower-level zone can be mounted by using the automount service. The pathname convention for such lower-level home mounts includes the zone name, as follows:

```
/zone/name-of-lower-level-zone/home/username
```

The following terminal window illustrates lower-level home directory visibility. A user whose login label is Confidential: Internal Use Only can view the contents of the Public zone when the automount service is configured to make lower-level zones readable. The `textfileInfo.txt` file has two versions. The Public zone version contains information that can be shared with the public. The Confidential: Internal Use Only version contains information that can be shared within the company only.

![Figure 1-6 Viewing Public Information From a Higher-Label Zone](image)

**Labels and Transactions**

Trusted Extensions software manages all attempted security-related transactions. The software compares the subject's label with the object's label, then allows or disallows the transaction depending on which label is dominant. An entity’s label is said to dominate another entity’s label if the following two conditions are met:

- The classification component of the first entity’s label is equal to the object’s classification or is higher than the object’s classification.
- All compartments in the second entity’s labels are included in the first entity’s label.

Two labels are said to be equal if the labels have the same classification and the same set of compartments. If the labels are equal, the labels dominate each other. Therefore, access is permitted.

If one of the following conditions is met, then the first label is said to strictly dominate the second label.
- The first label has a higher classification than a second label
- The first label’s classification is equal to a second label’s classification, the first label includes the second label’s compartments, and the first label has additional compartments

A label that strictly dominates a second label is permitted access to the second label.

Two labels are said to be disjoint if neither label dominates the other label. Access is not permitted between disjoint labels.

For example, consider the following figure.

<table>
<thead>
<tr>
<th>Classification</th>
<th>Compartments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Secret</td>
<td>A</td>
</tr>
</tbody>
</table>

Four labels can be created from these components:

- TOP SECRET
- TOP SECRET A
- TOP SECRET B
- TOP SECRET AB

TOP SECRET AB dominates itself and strictly dominates the other labels. TOP SECRET A dominates itself and strictly dominates TOP SECRET. TOP SECRET B dominates itself and strictly dominates TOP SECRET. TOP SECRET A and TOP SECRET B are disjoint.

In a read transaction, the subject’s label must dominate the object’s label. This rule ensures that the subject’s level of trust meets the requirements for access to the object. That is, the subject’s label includes all compartments that are allowed access to the object. TOP SECRET A can read TOP SECRET A and TOP SECRET data. Similarly, TOP SECRET B can read TOP SECRET B and TOP SECRET data. TOP SECRET A cannot read TOP SECRET B data. Nor can TOP SECRET B read TOP SECRET A data. TOP SECRET AB can read the data at all labels.

In a write transaction, that is, when a subject creates or modifies an object, the resulting object’s labeled zone must equal the subject’s labeled zone. Write transactions are not allowed from one zone to a different zone.

In practice, subjects and objects in read and write transactions usually have the same label and strict dominance does not have to be considered. For example, a TOP SECRET A subject can create or modify a TOP SECRET A object. In Trusted Extensions, the TOP SECRET A object is in a zone that is labeled TOP SECRET A.

The following table illustrates dominance relationships among U.S. Government labels and among a set of industry labels.
TABLE 1–1  Examples of Label Relationships in Trusted Extensions

<table>
<thead>
<tr>
<th>Label 1</th>
<th>Relationship</th>
<th>Label 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>U.S. Government Labels</td>
<td>(strictly) dominates</td>
<td>TOP SECRET</td>
</tr>
<tr>
<td>TOP SECRET AB</td>
<td>(strictly) dominates</td>
<td>SECRET A</td>
</tr>
<tr>
<td>TOP SECRET AB</td>
<td>(strictly) dominates</td>
<td>SECRET A B</td>
</tr>
<tr>
<td>TOP SECRET AB</td>
<td>(strictly) dominates</td>
<td>TOP SECRET A</td>
</tr>
<tr>
<td>TOP SECRET AB</td>
<td>dominates (equals)</td>
<td>TOP SECRET AB</td>
</tr>
<tr>
<td>TOP SECRET AB</td>
<td>is disjoint with</td>
<td>TOP SECRET C</td>
</tr>
<tr>
<td>TOP SECRET AB</td>
<td>is disjoint with</td>
<td>SECRET C</td>
</tr>
<tr>
<td>TOP SECRET AB</td>
<td>is disjoint with</td>
<td>SECRET A B C</td>
</tr>
<tr>
<td>Industry Labels</td>
<td>Confidential: Restricted</td>
<td>dominates</td>
</tr>
<tr>
<td>Confidential: Restricted</td>
<td>dominates</td>
<td>Confidential: Internal Use Only</td>
</tr>
<tr>
<td>Confidential: Restricted</td>
<td>dominates</td>
<td>Confidential: Internal Use Only</td>
</tr>
<tr>
<td>Confidential: Restricted</td>
<td>dominates</td>
<td>Public</td>
</tr>
<tr>
<td>Confidential: Need to Know</td>
<td>dominates</td>
<td>Confidential: Internal Use Only</td>
</tr>
<tr>
<td>Confidential: Need to Know</td>
<td>dominates</td>
<td>Public</td>
</tr>
<tr>
<td>Confidential: Internal</td>
<td>dominates</td>
<td>Public</td>
</tr>
<tr>
<td>Sandbox</td>
<td>is disjoint with</td>
<td>All other labels</td>
</tr>
</tbody>
</table>

When you transfer information between files with different labels, Trusted Extensions displays a confirmation dialog box if you are authorized to change the label of the file. If you are not authorized to do so, Trusted Extensions disallows the transaction. The security administrator can authorize you to upgrade or downgrade information. For more information, see “Performing Trusted Actions” on page 51.

User Responsibilities for Protecting Data

As a user, you are responsible for setting the permissions to protect your files and directories. Actions that you can perform to set permissions use a mechanism called discretionary access control (DAC). You can check the permissions on your files and directories by using the ls -l command or by using the File Manager, as described in Chapter 3, “Working in Trusted Extensions (Tasks).”
Mandatory access control (MAC) is enforced automatically by the system. If you are authorized to upgrade or downgrade labeled information, you have a critical responsibility to ensure that the need for changing the level of information is legitimate.

Another aspect of protecting data involves email. Never follow instructions that you receive in email from an administrator. For example, if you followed emailed instructions to change your password to a particular value, you would enable the sender to log in to your account. In limited cases, you might verify the instructions independently before following the instructions.

Trusted Extensions Separates Information by Label

Trusted Extensions separates information at different labels by the following means:

- Users can select single-level or multilevel sessions.
- The desktops provide workspaces that are labeled.
- Files are stored in separate zones according to label.
- MAC is enforced for all transactions, including email.
- Data on objects is erased prior to object reuse.

Single-Level or Multilevel Sessions

When you first log in to a Trusted Extensions session, you specify whether to operate at a single label or at multiple labels. You then set your session clearance or session label. This setting is the security level at which you intend to operate.

In a single-label session, you can access only those objects that are equal to your session label or are dominated by the label.

In a multilevel session, you can access information at labels that are equal to or lower than your session clearance. You can specify different labels for different workspaces. You can also have different workspaces at the same label.

Session Selection Example

Table 1–2 provides an example that shows the difference between a single-level and a multilevel session. This example contrasts a user who chooses to operate in a single-level session at CONFIDENTIAL: NEED TO KNOW (CNF: NTK) with a user who chooses a multilevel session, also at CNF: NTK.

The three columns on the left show each user’s session selections at login. Note that users set session labels for single-level sessions and session clearances for multilevel sessions. The system displays the correct label builder according to your selection. To view a label builder for a multilevel session, see Figure 2–2.
The two columns on the right show the label values that are available in the session. The Initial Workspace label column represents the label when the user first accesses the system. The Available Labels column lists the labels that the user is permitted to switch to during the session.

**TABLE 1–2  Effect of Initial Label Selection on Available Session Labels**

<table>
<thead>
<tr>
<th>Session Type</th>
<th>Session Label</th>
<th>Session Clearance</th>
<th>Initial Workspace Label</th>
<th>Available Labels</th>
</tr>
</thead>
<tbody>
<tr>
<td>single-level</td>
<td>CNF: NTK</td>
<td>-</td>
<td>CNF: NTK</td>
<td>CNF: NTK</td>
</tr>
<tr>
<td>multilevel</td>
<td>-</td>
<td>CNF: NTK</td>
<td>Public</td>
<td>Public</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>CNF: Internal Use Only</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>CNF: NTK</td>
</tr>
</tbody>
</table>

As the first row of the table shows, the user has selected a single-level session with a session label of CNF: NTK. The user has an initial workspace label of CNF: NTK, which is also the only label at which the user can operate.

As the second row of the table shows, the user has selected a multilevel session with a session clearance of CNF: NTK. The user’s initial workspace label is set to Public, because Public is the lowest possible label in the user’s account label range. The user can switch to any label between Public and CNF: NTK. Public is the minimum label, and CNF: NTK is the session clearance.

**Labeled Workspaces**

In Solaris Trusted Extensions (CDE), or Trusted CDE, the workspaces in Trusted Extensions are accessed through buttons in the center of the Front Panel, as in the Solaris OS. However, with Trusted Extensions, you can devote a workspace entirely to a single label. This setup is very convenient when you are in a multilevel session, and you do not want to confuse information at different labels. The following illustration shows the workspace switch area with four switches. Each switch opens a workspace at a different label. You can also assign several workspaces to the same label.

**FIGURE 1–7  Workspace Switch Area**

In Solaris Trusted Extensions (JDS), or Trusted JDS, the workspaces are accessed through buttons at the right of the bottom panel, as the following illustration shows. Each workspace has a label.
You can assign the same label to several workspaces, and you can assign different labels to different workspaces. Windows that are launched in a workspace have the label of that workspace. When the window is moved to a workspace of a different label, the window retains its original label. Thus, you can arrange windows of different labels in one workspace.

**Enforcing MAC for Email Transactions**

Trusted Extensions enforces MAC for email. You can send and read email at your current label. You can receive email at a label within your account range. In a multilevel session, you can switch to a workspace at a different label to read email at that label. You use the same mail reader and the same login. The system permits you to read mail at your current label only.

**Erasing Data on Objects Prior to Object Reuse**

Trusted Extensions prevents inadvertent exposure of sensitive information by automatically erasing old information from user-accessible objects prior to reuse. For example, memory and disk space are cleared before being used again. Failure to erase sensitive data prior to reuse of the object risks the exposure of data to inappropriate users. Through device deallocation, Trusted Extensions clears all user-accessible objects prior to allocating the drives to processes. Note, however, that you must clear all removable storage media, such as DVDs and JAZ drives, before allowing another user access to the drive.

**Trusted Extensions Enables Secure Administration**

In contrast to traditional UNIX systems, superuser (the root user) is not used to administer Trusted Extensions. Rather, administrative roles with discrete capabilities administer the system. In this way, no single user can compromise a system's security. A role is a special user account that provides access to certain applications with the rights that are necessary for performing the specific tasks. Rights include authorizations, privileges, and effective UIDs/GIDs.
The following security practices are enforced on a system that is configured with Trusted Extensions:

- You are granted access to applications and authorizations on a need-to-use basis.
- You can perform functions that override security policy only if you are granted special authorizations or special privileges by administrators.
- System administration duties are divided among multiple roles.

**Accessing Applications in Trusted Extensions**

In Trusted Extensions, you can access only those programs that you need to do your job. As in the Solaris OS, an administrator provides access by assigning one or more rights profiles to your account. A rights profile is a special collection of programs and security attributes. These security attributes enable successful use of the program that is in the rights profile.

The Solaris OS provides security attributes such as privileges and authorizations. Trusted Extensions provides labels. Any of these attributes, if missing, can prevent use of the program or parts of the program. For example, a rights profile might include an authorization that enables you to read a database. A rights profile with particular security attributes might be required for you to modify the database or read information that is classified as Confidential.

The use of rights profiles that contain programs with associated security attributes helps prevent users from misusing programs and from damaging data on the system. If you need to perform tasks that override the security policy, the administrator can assign to you a rights profile that contains the necessary security attributes. If you are prevented from running a certain task, check with your administrator. You might be missing required security attributes.

In addition, the administrator might assign you a profile shell as your login shell. A profile shell is a special version of the Bourne shell that provides access to a particular set of applications and capabilities. Profile shells are a feature of the Solaris OS. For details, see the `pfsh(1)` man page.

**Note** – If you try to run a program and receive a Not Found error message or if you try to run a command and receive a Not in Profile error message, you might not be permitted to use this program. Check with your security administrator.
Administration by Role in Trusted Extensions

Trusted Extensions software uses roles for administration. Make sure that you know who is performing which set of duties at your site. The following are common roles:

- root role – Is used primarily to prevent direct login by superuser.
- Primary Administrator role – Performs any tasks that require privileges beyond the capabilities of other roles.
- Security Administrator role – Performs security-relevant tasks, such as setting passwords, authorizing device allocation, assigning rights profiles, and evaluating software programs.
- System Administrator role – Performs standard system management tasks, such as setting up home directories, restoring backups, and installing software programs.
- Operator role – Performs system backups, manages printers, and mounts removable media.
This chapter describes the two desktops and the login process on a system that is configured with Solaris Trusted Extensions. This chapter covers the following topics:

- “Desktops and Login in Trusted Extensions” on page 31
- “Trusted Extensions Login Process” on page 32
- “Logging In to Trusted Extensions” on page 33
- “Logging In Remotely to Trusted Extensions” on page 37

### Desktops and Login in Trusted Extensions

The desktop that you use in Trusted Extensions is protected. Labels provide a visible indication of protection. Applications, data, and your communications are labeled.

The desktops are trusted versions of the Common Desktop Environment (CDE), and the Sun Java Desktop System:

- **Solaris Trusted Extensions (CDE)** – Is the trusted version of CDE. This desktop is useful for single-level and multilevel sessions. Use the Trusted CDE desktop if you are familiar with CDE, or if site policy requires you to use this desktop.

- **Solaris Trusted Extensions (JDS)** – Is the trusted version of Java Desktop System, Release *number*. This desktop is useful for single-level and multilevel sessions. Trusted JDS includes accessibility features, such as a screen magnifier. Use this desktop if you are familiar with GNOME or the Java Desktop System, or if site policy requires you to use this desktop. Do not use this desktop if you are authorized to change the label of files, and you plan to drag and drop files to change their labels. Use the Trusted CDE desktop to drag and drop files to change their labels.

The login screen is not labeled. The login process requires you to establish a label for your session. Once you have chosen a label, the desktop, its windows, and all applications are labeled. In addition, applications that affect security are visibly protected by a trusted path indicator.
Trusted Extensions Login Process

The login process on a system that is configured with Trusted Extensions is similar to the login process for the Solaris OS. However, in Trusted Extensions, you examine several screens for security-relevant information before the desktop session can be started. The process is described in more detail in the sections that follow. Here is a brief overview.

1. Desktop choice – As in the Solaris OS, you choose which desktop to use. In Trusted Extensions, you must choose one of two trusted desktops.
2. Identification – As in the Solaris OS, you type your username in the Username field.
3. Authentication – As in the Solaris OS, you type your password in the Password field. Successful completion of identification and authentication confirms your right to use the system.
4. Message checking and session type selection – You examine the information in the Last Login dialog box. This dialog box displays the time you last logged in, any messages from the administrator, and the security attributes of your session. If you are permitted to operate at more than one label, you can specify the type of session, single-level or multilevel.

Note – If your account restricts you to operate at one label, you cannot specify the type of session. This restriction is called a single-level or single-label configuration. For an example, see “Session Selection Example” on page 25.

5. Label selection – In the label builder, you choose the highest security level at which you intend to work while in your session.

Note – By default, remote login is not supported for regular users in Trusted Extensions. If remote login is supported by your site, check with your administrator for the procedure. Starting in the Solaris 10 5/09 release, a virtual networking computer (vnc) can be used to remotely display a multilevel desktop. For the procedure, see "Logging In Remotely to Trusted Extensions" on page 37.

Desktop Choice Before Login

When a Solaris workstation is not in a work session, it displays the login screen. The Trusted Extensions login screen is similar to the Solaris login screen. As in the Solaris login screen, you can choose a desktop from the Options menu.
Identification and Authentication During Login

Identification and authentication during login are handled by the Solaris OS. The login screen initially contains the Username prompt. This part of the login process is referred to as identification.

After you have entered the username, the password prompt is displayed. This part of the process is referred to as authentication. The password authenticates that you are indeed the user who is authorized to use that username.

A password is a private combination of keystrokes that validates your identity to the system. Your password is stored in an encrypted form and is not accessible by other users on the system. It is your responsibility to protect your password so that other users cannot use it to gain unauthorized access. Never write down your password or disclose it to anyone else because a person with your password has access to all your data without being identifiable or accountable. Your initial password is supplied by your security administrator.

Review Security Attributes During Login

The review of security attributes is handled by Trusted Extensions, not by the Solaris OS. Before login is complete, Trusted Extensions displays the Last Logind dialog box. This dialog box provides status information for you to review. You can review past information, such as when the system was last used by you. You can also review the security attributes that are in effect for the upcoming session. If your account is configured to operate at more than one label, you can select a single-level or a multilevel session.

You then view your single label, or choose a label and clearance from the label builder.

Logging In to Trusted Extensions

The following tasks step you through logging in to Trusted Extensions. You review and specify security information before reaching the desktop.

▼ Choose a Trusted Desktop

1. On the login screen, choose a desktop from the Options --> Sessions menu.
   - For Trusted CDE, choose Solaris Trusted Extensions (CDE).
   - For Trusted JDS, choose Solaris Trusted Extensions (JDS).

2. Continue with “Identify and Authenticate Yourself to the System” on page 34.
Identify and Authenticate Yourself to the System

1. In the Username field of the login screen, type your username.
   Be sure to type your username exactly as your administrator assigned it to you. Pay attention to spelling and capitalization.

2. If you made an error, restart.
   - To retypen your username, click Start Over.
   - To restart the windowing system completely, click Reset Login from the Options menu.
     Go to "Choose a Trusted Desktop” on page 33 after your restart.

3. Confirm your entry.
   Press Return to confirm your username.

   Caution – You should never see the trusted stripe when the login screen appears. If you ever see the trusted stripe while attempting to log in or unlock the screen, do not type your password. There is a possibility that you are being spoofed. A spoof is when an intruder’s program is masquerading as a login program to capture passwords. Contact your security administrator immediately.

4. Type your password in the password entry field, and press Return.
   For security purposes, the characters do not display in the field. The system compares the login name and password against a list of authorized users.

   Troubleshooting
   If the password that you provided is incorrect, a dialog box appears with the message:
   Login incorrect; please try again.
   Click OK to dismiss the error dialog box. Then, type the correct password.

Check Messages and Select Session Type

If you do not restrict yourself to a single label, you can view data at different labels. The range in which you can operate is bounded at the upper end by the session clearance and at the lower end by the minimum label that your administrator assigned to you.

1. In the Last Login dialog box, check that the time of your last session is accurate.
   Always check that nothing is suspicious about the last login, such as an unusual time of day. If you have reason to believe that the time is not accurate, contact your security administrator.
2 Check for any messages from the administrator.

The Message of the Day field can contain warnings about scheduled maintenance or security problems. Always review the information in this field.

3 Examine the security attributes of your session.

As Figure 2–1 shows, the Last Login dialog box indicates any roles that you can assume, your minimum label, and other security characteristics.

4 (Optional) If you are permitted to log in to a multilevel session, decide if you want a single-label session.

Click the Restrict Session to a Single Label button to log in to a single-label session.

You are presented with a label builder. If you are logging in at a single label, the label builder describes your session label. In a multilevel system, the label builder enables you to choose your session clearance.

5 Confirm your label choice.
Accept the default, unless you have a reason not to.

For a multilevel session, select a clearance.
  • Deselect the current clearance, and click a classification and a sensitivity label.
  • Or, in the Clearance field, type a clearance.
  • Or, in the Update With field, type a label.

For a single-level session, select a label.
  • Deselect the current label, and click a different classification.
  • Or, in the Update With field, type a label.

6 Click OK.
The trusted desktop that you chose, either Trusted CDE or Trusted JDS, appears.
Troubleshoot Login Problems

1. If your username or password is not recognized, check with the administrator.

2. If your label range is not permitted on your workstation, check with the administrator.
   Workstations can be restricted to a limited range of session clearances and labels. For example, a workstation in a lobby might be limited to PUBLIC labels only. If the label or session clearance that you specify is not accepted, check with an administrator to determine if the workstation is restricted.

3. If you have customized your shell initialization files and cannot log in, you have the following two options.
   - Contact your system administrator to correct the situation.
   - If you can become root, log in to a failsafe session.
     In a standard login, the shell initialization files are sourced at startup to provide a customized environment. In a failsafe login, the default values are applied to your system and no shell initialization files are sourced.
     In Trusted Extensions, failsafe login is protected. Only superuser can access failsafe login.
       a. As in the Solaris OS, choose Options -> Failsafe Session on the login screen.
       b. When prompted, provide your username and password.
       c. When prompted for an additional password, provide the password for root.

Logging In Remotely to Trusted Extensions

Virtual Network Computing (vnc) provides a way for you to access a central Trusted Extensions system from your laptop or home computer. The administrator at your site must configure the Solaris Xvnc software to run on the Trusted Extensions server and the Solaris vnc software to run on the client systems. You can work at any label in your label range that is installed on the server.

How to Log In to a Remote Trusted Extensions Desktop

Before You Begin
Your administrator has completed "How to Use Xvnc to Remotely Access a Trusted Extensions System" in Oracle Solaris Trusted Extensions Administrator's Procedures.
1  **In a terminal window, connect to the Xvnc server.**
   Type the name of the server that your administrator has configured with Xvnc.
   
   ```
   % /usr/bin/vncviewer Xvnc-server
   ```

2  **Log in.**

   Follow the procedures in “Logging In to Trusted Extensions” on page 33.
   You can now work on the Trusted Extensions desktop in the vnc viewer.
This chapter discusses how to work in Solaris Trusted Extensions workspaces. This chapter covers the following topics:

- “Visible Desktop Security in Trusted Extensions” on page 39
- “Trusted Extensions Logout Process” on page 40
- “Working on a Labeled System” on page 40
- “Performing Trusted Actions” on page 51

Visible Desktop Security in Trusted Extensions

Trusted Extensions offers two labeled desktops, the Solaris Trusted Extensions (CDE) desktop and the Solaris Trusted Extensions (JDS) desktop.

- The Solaris Trusted Extensions (CDE) desktop appears similar to the following, Figure 1–4.
- The Solaris Trusted Extensions (JDS) desktop appears similar to the following, Figure 1–5.

A system that is configured with Trusted Extensions displays the trusted stripe except during login and screen lock. At all other times, the trusted stripe is visible. In Trusted CDE, the stripe is at the bottom of the screen. In Trusted JDS, the stripe is at the top of the screen. The trusted symbol appears on the trusted stripe when you interact with the trusted computing base. When you change your password, for example, you interact with the TCB.

When the monitors of a multiheaded Trusted Extensions system are configured horizontally, one trusted stripe appears across the monitors. However, if the multiheaded system is configured to display vertically, or has separate desktops, one per monitor, then the trusted stripe appears on one monitor only.
Caution – If a second trusted stripe appears on a multiheaded system, the stripe is not generated by the operating system. You might have an unauthorized program on your system.

Contact your security administrator immediately. To determine the correct trusted stripe, see “How to Regain Control of the Desktop’s Current Focus” in Oracle Solaris Trusted Extensions Administrator’s Procedures.

For details about the applications, menus, labels, and features of the desktop, see Chapter 4, “Elements of Trusted Extensions (Reference).”

Trusted Extensions Logout Process

A workstation that is logged in to, but left unattended, creates a security risk. Make a habit of securing your workstation before you leave. If you plan to return soon, lock your screen. At most sites, the screen automatically locks after a specified period of idleness. If you expect to be gone for awhile, or if you expect someone else to use your workstation, log out.

Working on a Labeled System

Caution – If the trusted stripe is missing from your workspace, contact the security administrator. The problem with your system could be serious.

The trusted stripe should not appear during login, or when you lock your screen. If the trusted stripe shows, contact the administrator immediately.

▼ How to Lock and Unlock Your Screen

If you leave your workstation briefly, lock the screen.

1. **To lock your screen, do one of the following:**
   - In Trusted CDE, click the screen lock icon in the workspace switch area of the Front Panel.
In Trusted JDS, choose Lock Screen from the Main menu.

The screen turns black. At this point, only you can log in again.

**Note** – The trusted stripe should not appear when the screen is locked. If the stripe does appear, notify the security administrator immediately.

2. **To unlock your screen, do the following:**

   a. **Move your mouse until the Lock Screen dialog box is visible.**
      
      If the Lock Screen dialog box does not appear, press the Return key.
b. Type your password.
   This action returns you to your session in its previous state.

▼ How to Log Out of Trusted Extensions

At most sites, the screen automatically locks after a specified period of idleness. If you expect to
leave the workstation for awhile, or if you expect someone else to use your workstation, log out.

1 To log out, do one of the following:
   
   ■ In Trusted CDE, click the EXIT icon in the workspace switch area of the Front Panel.
     For a picture of the Front Panel, see Figure 3–1.
     The Logout Confirmation dialog box is displayed.

     ![Logout Confirmation](image)

     ■ In Trusted JDS, choose Log Out your-name from the Main menu.
     The Logout Confirmation dialog box is displayed.

     ![Logout Confirmation](image)

2 Confirm the logout, or click Cancel.
How to Shut Down Your System

Logging out is the normal way to end a Trusted Extensions session. Use the following procedure if you need to turn off your workstation.

**Note** – If you are not on the console, you cannot shut down the system. For example, Sun Ray clients cannot shut down the system.

To shut down the system, do one of the following:

- In Trusted JDS, choose Shut Down from the Main menu.
  Confirm the shutdown.

- In Trusted CDE, choose Suspend System from the Workspace menu.
  Click mouse button 3 over the background to open the menu.
  
  a. Confirm what you want to do.
  
  - Click Shutdown to shut down your system.
  
  - Click Suspend to put your system in power-saving mode.
  
  - Otherwise, click Cancel.

**Note** – By default, the keyboard combination Stop-A (L1-A) is not available in Trusted Extensions. The security administrator can change this default.
How to View Your Files in a Labeled Workspace

To view your files, you use the same applications that you would use in Trusted CDE or Trusted JDS on a Solaris system. If you are working at multiple labels, only the files that are at the label of the workspace are visible.

1. In a Trusted CDE workspace, open a terminal window or the File Manager.
   - Open a terminal window and list the contents of your home directory.
     Click mouse button 3 over the background. From the Workspace menu, choose Programs -> Terminal.
   - On the Front Panel, click the File Manager.

   ![A Labeled File Manager](image)

   The File Manager appears with the contents of your home directory at that label.
   The File Manager opens at the same label as the current workspace. The application provides access to only those files that are at its label. For details about viewing files at different labels, see "Containers and Labels" on page 21.

2. In a Trusted JDS workspace, open a terminal window or the File Browser.
   - Open a terminal window and list the contents of your home directory.
     Click mouse button 3 over the background. From the menu, choose Open Terminal.
Double-click the Documents folder or the This Computer folder on your desktop. These folders open in a File Browser. The File Browser application opens at the same label as the current workspace. The application provides access to only those files that are at its label. For details about viewing files at different labels, see “Containers and Labels” on page 21.

### How to Access the Trusted Extensions Man Pages

1. In the Solaris 10 11/06 and Solaris 10 8/07 releases of Solaris Trusted Extensions, review the Intro(3TSOL) man page.
   a. Open a terminal window.
      - In Trusted CDE, click mouse button 3 over the background. Then, choose Programs -> Terminal.
      - In Trusted JDS, click mouse button 3 over the background. Then, choose Open Terminal.
   b. Open the Trusted Extensions introductory man page.
      ```
      % man -s 3tsol intro
      ```
      For a list of user commands that are specific to Trusted Extensions, see Appendix B, “List of Trusted Extensions Man Pages,” in Oracle Solaris Trusted Extensions Administrator’s Procedures.
      
      The man pages are also available from Sun’s documentation web site (http://docs.sun.com/).

2. Starting in the Solaris 10 5/08 release, review the trusted_extensions(5) man page in a terminal window.
   ```
   % man trusted_extensions
   ```
   For a list of user commands that are specific to Trusted Extensions, see Appendix B, “List of Trusted Extensions Man Pages,” in Oracle Solaris Trusted Extensions Administrator’s Procedures.

### How to Access Trusted Extensions Online Help

1. In Trusted CDE, click the Help icon on the Front Panel.
a. Click the Index button.

b. In the index, search All Volumes for the word Trusted.

c. Click the links to find help that is specific to Trusted Extensions.

2 In Trusted JDS, click Help from the Trusted Path menu.

   ▪ To open the Trusted Path menu, click the trusted symbol at the left of the trusted stripe.

   ▪ To find task-specific help, click the Help button on the trusted application that you are currently using, such as the Device Manager.

▼ How to Customize the CDE Workspace Menu

In Trusted CDE, users and roles can customize the Workspace menu for each distinct label.

1 In your current workspace, start to customize the Workspace menu.

   ▪ To add one or more items to the menu, choose the Add Item to Menu item.

      A dialog box with a Browse button appears.
To modify the menu or menu properties, choose Customize Menu item.
A File Manager appears.

2 If you are adding items to the Workspace menu, do the following:
   a. For each program, find the program and add it.
      Click the Browse button to show the files that are available for this workspace at this label.
   b. Select the program.
   c. Close the window.
      The items are added to the top of the Workspace menu.

3 If you are modifying the Workspace menu, do the following:
   ■ To remove a menu item, click mouse button 3 over the item and click Put in Trash.
   ■ To change properties, such as permissions, click mouse button 3 over the item and click Properties.
      You can modify permissions here. You can also view file information and file sensitivity label.

4 Confirm the menu changes, or cancel.
   ■ To confirm your changes, choose File → Update Workspace Menu.
      The Workspace menu reflects your changes.
   ■ To cancel your changes, choose File → Close.

How to Access Initialization Files at Every Label
Linking a file or copying a file to another label is useful when you want to make a file with a lower label visible at higher labels. The linked file is only writable at the lower label. The copied file is unique at each label and can be modified at each label. For more information, see "COPY_FILES and LINK_FILES Files" in Oracle Solaris Trusted Extensions Administrator’s Procedures.

Before You Begin
You must be logged in to a multilevel session. Your site’s security policy must permit linking.
Work with your administrator when modifying these files.

1 Decide which initialization files you want to link to other labels.
2 **Create or modify the ~/.link_files file.**
Type your entries one file per line. You can specify paths to subdirectories in your home directory, but you cannot use a leading slash. All paths must be within your home directory.

3 **Decide which initialization files you want to copy to other labels.**
Copying an initialization file is useful when you have an application that always writes to a file with a specific name, and you need to separate the data at different labels.

4 **Create or modify the ~/.copy_files file.**
Type your entries one file per line. You can specify paths to subdirectories in your home directory, but you cannot use a leading slash. All paths must be within your home directory.

**Example 3–1 Creating a .copy_files File**
In this example, the user wants to customize several initialization files per label. In her organization, a company web server is available at the Restricted level. So, she sets different initial settings in the .mozilla file at the Restricted level. Similarly, she has special templates and aliases at the Restricted level. So, she modifies the .aliases and .soffice initialization files at the Restricted level. She can easily modify these files after creating the .copy_files file at her lowest label.

```
% vi .copy_files
# Copy these files to my home directory in every zone
 .aliases
 .mozilla
 .soffice
```

**Example 3–2 Creating a .link_files File**
In this example, the user wants her mail defaults and shell defaults to be identical at all labels.

```
% vi .link_files
# Link these files to my home directory in every zone
 .cshrc
 .mailrc
```

**Troubleshooting** These files do not have safeguards for dealing with anomalies. Duplicate entries in both files or file entries that already exist at other labels can cause errors.
How to Interactively Display a Window Label

This operation can be useful to identify the label of a partially hidden window.

1. Choose Query Window Label from the Trusted Path menu.
   The pointer changes to a question mark.

2. Move the pointer around the screen.
   The label for the region under the pointer is displayed in a small rectangular box at the center of the screen.

3. Click the mouse button to end the operation.

FIGURE 3–5   Query Window Label Operation
How to Perform Some Common Desktop Tasks in Trusted Extensions

Some common tasks are affected by labels and security. In particular, the following tasks are affected by Trusted Extensions:

- Emptying the trash
- Finding calendar events
- In Trusted CDE, restoring the Front Panel and using the Style Manager

1 Empty the trash.
The trash can contains files only at the label of the workspace. Delete sensitive information as soon as the information is in the trash can.

   - **In Trusted CDE, open the Trash Can on the Front Panel.**
     Choose File -> Select All, then File -> Shred. Then, confirm.

   - **In Trusted JDS, click mouse button 3 over the Trash Can icon on the desktop.**
     Choose Empty Trash, then confirm.

2 Find calendar events at every label.
Calendars show only the events at the label of the workspace that opened the calendar.

   - **In a multilevel session, open your calendar from a workspace that has a different label.**

   - **In a single-level session, log out. Then, log in at a different label to view the calendar events at that label.**

3 In Trusted CDE, restore the Front Panel by clicking the trusted stripe.
A minimized Front Panel is restored.

4 On both desktops, save a customized desktop at every label.
You can customize the workspace configuration for every label at which you log in.

   a. **Configure the desktop.**
      Arrange windows, establish the font size, and perform other customizations.

      **Note** – Users can save desktop configurations. Roles cannot save desktop configurations.

   b. **Save the current workspace.**
      - **In Trusted CDE, open the Style Manager. Choose your settings in the Startup icon.**
Performing Trusted Actions

The following security-related tasks require the trusted path.

**Caution** – If the trusted symbol is missing when you are attempting a security-related action, contact your security administrator at once. The problem on your system could be serious.

**How to Change Your Password in Trusted Extensions**

Unlike the Solaris OS, Trusted Extensions provides a GUI for changing your password. The GUI grabs the pointer until the password operation is completed. To stop a process that has grabbed the pointer, see “How to Regain Control of the Desktop’s Current Focus” in *Oracle Solaris Trusted Extensions Administrator’s Procedures*.

1. Choose Change Password from the Trusted Path menu.

   - In Trusted JDS, click **Trusted Path** in the trusted stripe.
Performing Trusted Actions

In Trusted CDE, open the Trusted Path menu from the center of the Front Panel.

2 Type your current password.
   This action confirms that you are the legitimate user for this user name. For security reasons, the password is not displayed as you type.

   Caution – When you type your password, make sure that the cursor is over the Change Password dialog box and that the trusted symbol is displayed. If the cursor is not over the dialog box, you might inadvertently type your password into a different window where the password could be seen by another user. If the trusted symbol is not displayed, then someone might be attempting to steal your password. Contact your security administrator at once.

3 Type the new password.

4 Confirm the password by retyping it.

How to Log In at a Different Label

The label of the first workspace that appears in subsequent login sessions after the first login can be set to any label within your label range.

Users can configure the startup session characteristics for every label at which they log in.

Before You Begin

You must be logged in to a multilevel session.

1 Create workspaces at every label.
   For details, see “How to Add a Workspace at a Particular Label” on page 58.
2 Configure each workspace as you want the workspace to appear.

3 Go to the workspace that you want to see when you log in.

4 Save this current workspace.
   For details, see “How to Perform Some Common Desktop Tasks in Trusted Extensions” on page 50.

▼ How to Allocate a Device in Trusted Extensions

The Allocate Device menu item enables you to mount and allocate a device for your exclusive use. If you try to use a device without allocating it, you get the error message "Permission Denied".

Before You Begin

You must be authorized to allocate a device.

1 Choose Allocate Device from the Trusted Path menu
   Or, in Trusted CDE, open the Device Allocation Manager from the Tools subpanel in the Front Panel.

   FIGURE 3–7  Device Allocation Icon in Trusted CDE

   The Device Allocation Manager is displayed. In Solaris Trusted Extensions (JDS), this GUI is called the Device Manager.
2 **Double-click the device that you want to use.**

The devices that you are permitted to allocate at your current label appear under Available Devices:

- `audio` – Indicates a microphone and speaker
- `cdrom` – Indicates a CD-ROM drive
- `floppy` – Indicates a diskette drive
- `mag_tape` – Indicates a tape drive (streaming)
- `rmdisk` – Indicates a removable disk, such as a JAZ or ZIP drive, or USB hot-pluggable media

3 **Select the device.**

Move the device from the Available Devices list to the Allocated Devices list.

- Double-click the device name in the Available Devices list.

- Or, select the device and click the Allocate button that points to the right.

This step starts the clean script. The clean script ensures that no data from other transactions remains on the media.

Note that the label of the current workspace is applied to the device. Any data transferred to or from the device's media must be dominated by this label.

4 **Follow the instructions.**

The instructions ensure that the media has the correct label. For example, the following instructions appear for microphone use.
Then, the device is mounted. The device name now appears in the Allocated Devices list. This device is now allocated for your exclusive use.

Example 3–3  Loading Removable Media to Read a File System

In this example, a user wants to load information onto her system from a CD-ROM that is labeled \textit{SECRET}. She is authorized to allocate the CD-ROM.

First, she creates a workspace at the label \textit{SECRET}. In this workspace, she opens the Device Allocation Manager, and allocates the CD-ROM drive. Then, she inserts the CD and responds yes to the mount query.

The software mounts the CD and the File Manager appears. The current directory is set to the mount point.

Example 3–4  Allocating an Audio Device

In this example, a user allocates the audio device on her system. When she moves the audio device to the Allocated Device list, the following message appears:

The device is allocated at the label \textit{Confidential : Internal Use Only}. She views the label when she selects the device in the Allocated Device list.
When the user is finished with the audio device, she deallocates it. The system reminds her to turn off the microphone.

**Troubleshooting**

If the device that you want to use does not appear in the list, check with your administrator. The device could be in an error state or in use by someone else. Or, you might not be authorized to use the device.

If you switch to a different role workspace or to a workspace at a different label, the allocated device cannot work at that label. To use the device at the new label, you need to deallocate the device at the initial label, and then allocate the device at the new label. In Trusted CDE, when you use the Occupy Workspace command from the window menu to move the Device Allocation Manager to the new workspace, the Available and Allocated Devices lists change to reflect the correct context. The Device Manager in Trusted JDS works similarly when you move the GUI to a workspace at a different label.

If a File Manager or File Browser window does not appear, open the window manually, then navigate to the root directory, `/`. In this directory, navigate to the allocated device to view its contents.
How to Deallocate a Device in Trusted Extensions

1. Deallocate the device.
   a. Go to the workspace where the Device Allocation Manager is displayed.
   b. Move the device to be deallocated from the list of allocated devices.

2. Remove the media.

3. Click OK in the Deallocation dialog box.
   The device is now available for use by another authorized user.

How to Assume a Role in Trusted Extensions

Unlike the Solaris OS, Trusted Extensions provides a GUI for assuming a role.

1. Open the Trusted Path menu.
   - In Solaris Trusted Extensions (CDE), click the center of the Front Panel.
     If you have been assigned a role by the security administrator, the Trusted Path menu includes the Assume rolename Role menu item.
     Choose Assume rolename Role.
   - In Solaris Trusted Extensions (JDS), click your user name at the right of the trusted symbol.
     Choose the role name from the menu.

2. Type the role password and press Return.
   This action confirms that you can legitimately assume this role. For security reasons, the password is not displayed as you type.

Caution – When you type your password, make sure that the cursor is over the Change Password dialog box and that the trusted symbol is displayed. If the cursor is not over the dialog box, you might inadvertently type your password into a different window where the password could be seen by another user. If the trusted symbol is not displayed, then someone might be attempting to steal your password. Contact your security administrator at once.

After the role password is accepted, the software places you in a role workspace. In Trusted JDS, the current workspace becomes the role workspace. In Trusted CDE, a new workspace is created for the role. You are in the global zone. You can perform the tasks that are permitted by the rights profiles in your role.
How to Change the Label of a Workspace

The ability to set workspace labels in Trusted Extensions provides a convenient means of working at different labels within the same session.

Use this procedure to work in the same workspace at a different label. To create a workspace at a different label, see “How to Add a Workspace at a Particular Label” on page 58.

Before You Begin

You must be logged in to a multilevel session.

1 Change the workspace label of your current workspace.
   - In Trusted CDE, click mouse button 3 over the workspace button.
     From the menu, choose Change Workspace Label.
   - In Trusted JDS, click the window label in the trusted stripe.
     Click Change Workspace Label.

2 Choose a label from the label builder.
   The workspace label is changed to the new label. Windows and applications that were invoked before the label change continue to run at the previous label. The trusted stripe indicates the new label. In a system where labels are color-coded, new windows are marked with the new color. In Trusted CDE, the workspace button is color-coded. In Trusted JDS, the panel is color-coded.

How to Add a Workspace at a Particular Label

The ability to set workspace labels in Trusted Extensions provides a convenient means of working at different labels within the same session. On both desktops, you can add a workspace at your minimum label. In Trusted CDE, you can add a workspace at the label of an existing workspace.

Tip – In Trusted CDE, rename each workspace button to reflect the label of the workspace.

To change the label of the current workspace, see “How to Change the Label of a Workspace” on page 58.

Before You Begin

You must be logged in to a multilevel session.
1 In Trusted JDS, to create a workspace at your minimum label, do the following:
   a. Click mouse button 3 over a workspace panel.
   b. From the menu, choose Preferences.
   c. Increase the number in the Number of Workspaces field.
      The new workspaces are created at your minimum label. You can also use this dialog box to
      name the workspaces. The name appears in the tooltip.

   Note – In Trusted JDS, to add a workspace at a different label, you select a workspace panel
   and change its label. For details, see “How to Change the Label of a Workspace” on page 58.

2 In Trusted CDE, to create a workspace at your minimum label, do the following:
   a. Click mouse button 3 over the Workspace Switch Area.
   b. From the menu, choose Add Workspace.
      The workspace is created at your minimum label.
   c. (Optional) Rename the workspace.

3 In Trusted CDE, to create a workspace at the label of an existing workspace, do the following:
   a. Click mouse button 3 over the workspace button.
   b. From the menu, choose Add Workspace.
      The workspace is created at the label of the workspace button.

▼ How to Switch to a Workspace at a Different Label

   To switch to an existing workspace, perform one of the following:
   ▪ In Trusted CDE, click the workspace switch at that label.

FIGURE 3–10 Front Panel With Switches at Different Labels
Performing Trusted Actions

- In Trusted JDS, click the workspace panel on the panel display.

![Workspace Panel](image)

You are now in that labeled workspace.

**Troubleshooting**

If you are logged in to a single-level session, you must log out to work at a different label. Then, log in at the desired label. If you are permitted, you can also log in to a multilevel session.

▼ **How to Move a Window to a Different Workspace**

Windows that are moved to a different workspace retain their original label. Any actions that are done in those windows are done at the label of the window, not at the label of the containing workspace. Moving a window is useful when you want to compare information. You might also want to use applications at different labels without moving between workspaces.

- To move a window to a different workspace, perform one of the following:
  - In Trusted CDE, use the Occupy Workspace menu.
    - From the application's window menu, choose Occupy Workspace.

      ![Occupy Workspace Menu in Trusted CDE](image)

    - Choose a workspace at a different label, then click OK.

      This action moves the application to a workspace that has a different label. Note that the Occupy Workspace dialog box has the label Trusted Path. This label indicates that occupying a workspace affects the trusted computing base.

      The following figure shows two terminal windows at different labels in one workspace.
In Trusted JDS, in the panel display, drag the window from its original workspace panel to a different panel. The dragged window now appears in the second workspace.

How to Determine the Label of a File

Usually, the label of a file is obvious. However, if you are allowed to view files at a lower label than your current workspace, the label of a file might not be obvious. In particular, the label of a file can be different from the label of the File Browser or File Manager.

1 In Trusted CDE, use the File Manager to determine the label of the file.

   In the File Manager, select the file, then choose the File -> Properties menu item. Read the value of the file’s Sensitivity Label property.

   Or, drag the file from the containing File Manager onto the desktop. The file icon displays the label of the file.

2 In Trusted JDS, use the File Browser.

   Tip – You can also use the Query Label menu item from the Trusted Path menu.

How to Move Data Between Labels

As on a Solaris system, you can move data between windows in Trusted Extensions. However, the data must be at the same label. When you transfer information between windows with different labels, you are upgrading or downgrading the sensitivity of that information.

Before You Begin

Your site’s security policy must permit this type of transfer, the containing zone must permit relabeling, and you must be authorized to move data between labels.
Therefore, your administrator must have completed the following tasks:

- “How to Enable Files to be Relabeled From a Labeled Zone” in Oracle Solaris Trusted Extensions Administrator’s Procedures
- “How to Enable a User to Change the Security Level of Data” in Oracle Solaris Trusted Extensions Administrator’s Procedures

You must be logged into a multilevel session.

1 **Create workspaces at both labels.**
   For details, see “How to Add a Workspace at a Particular Label” on page 58.

2 **Confirm the label of the source file.**
   For details, see “How to Determine the Label of a File” on page 61.

3 **Move the window with the source information to a workspace at the target label.**
   For details, see “How to Move a Window to a Different Workspace” on page 60. The following figure shows two editors at different labels in the same workspace.

**FIGURE 3–13** Differently Labeled Applications in One Workspace
4 Highlight the information to be moved, and paste the selection in the target window.
The Selection Manager Confirmation dialog box is displayed.

![Selection Manager Confirmation Dialog Box in Trusted JDS](image)

5 Review the Selection Manager Confirmation dialog box.
This dialog box:
- Describes why confirmation of the transaction is needed.
- Identifies the label and the owner of the source file.
- Identifies the label and the owner of the destination file.
- Identifies the type of data that was selected for transfer, the type of the target file, and the size of the data in bytes. By default, the selected data is visible in text format.
- Indicates the time that remains for you to complete the transaction. The amount of time and the use of the timer depends on your site’s configuration.
6 (Optional) In the View As menu, choose how to view the source information.

- Choose hexadecimal to view the data in hexadecimal format.
- Choose None to hide the data altogether.
  
  By resetting the View As menu, you affect the displays of subsequent transfers. Choose None for selections that consist of unreadable data.

7 Confirm that you want the label of the data to change.

- Click Cancel to stop the transaction.
- Otherwise, click OK.

▼ How to Move Files Between Labels in Trusted CDE

As on a standard Solaris system, you can move files in Trusted Extensions. When you move a file to a different label, you are upgrading or downgrading the sensitivity of the information that is in the file.
Your site’s security policy must permit this type of transfer, the containing zone must permit relabeling, and you must be authorized to move files between labels.

Therefore, your administrator must have completed the following tasks:

- “How to Enable Files to be Relabeled From a Labeled Zone” in Oracle Solaris Trusted Extensions Administrator’s Procedures
- “How to Enable a User to Change the Security Level of Data” in Oracle Solaris Trusted Extensions Administrator’s Procedures

You must be logged in to a multilevel session in Trusted CDE. The file that you want to move must be closed. Verify that no one else is using this file.

1 **Create workspaces at both labels.**
   For details, see “How to Add a Workspace at a Particular Label” on page 58.

2 **Open File Managers at both labels.**
   For details, see “How to View Your Files in a Labeled Workspace” on page 44.

3 **In the source File Manager, navigate to the file whose label is to change.**

4 **In the target File Manager, navigate to the file's new directory.**

5 **Move the File Managers into one workspace.**
   For details, see “How to Move a Window to a Different Workspace” on page 60.
Performing Trusted Actions

6 Drag and drop the file to the target directory.
The FileManager Confirmation dialog box is displayed, as shown in Figure 3–18.

This dialog box is similar to the Selection Manager Confirmation dialog box, but does not include a timer. This dialog box:

- Describes why confirmation of the transaction is needed.
- Identifies the label and the owner of the source file.
- Identifies the label and the owner of the destination file.
- Identifies the type of data that was selected for transfer, the type of the target file, and the size of the data in bytes.
7 Confirm that you want the label of the file to change.

- Click Cancel to stop the transaction.
- Click Apply to move the file to the new label.

**Example 3–5** Linking a File to a Different Label

The linking of a file to another label is useful when you want to view a file with a lower label at a higher label. The file is writable only at the lower label.

To link a file, the user presses Shift-Control while dragging the file icon from the source File Manager to the target File Manager. Then, the user confirms the link, or cancels the operation.

**Troubleshooting** If your system is not configured to permit the upgrading or downgrading of labels, a dialog box that states that the transfer is not authorized is displayed. Check with your administrator.
Elements of Trusted Extensions (Reference)

This chapter explains the key elements of Solaris Trusted Extensions. This chapter covers the following topics:

- "Visible Features of Trusted Extensions" on page 69
- "Device Security in Trusted Extensions" on page 73
- "Files and Applications in Trusted Extensions" on page 73
- "Password Security in the Solaris OS" on page 74
- "Front Panel Security (Trusted CDE)" on page 75

Visible Features of Trusted Extensions

After you have successfully completed the login process, as explained in Chapter 2, "Logging Into Trusted Extensions (Tasks)," you can work within Trusted Extensions. Your work is subject to security restrictions. Restrictions that are specific to Trusted Extensions include the label range of the system, your clearance, and your choice of a single-level or multilevel session. As the following figure illustrates, four features distinguish a system that is configured with Trusted Extensions from a Solaris system. To view the features on a Trusted JDS desktop, see Figure 1–5.
Visible Features of Trusted Extensions

Label displays – All windows, workspaces, files, and applications have a label. The desktop provides label stripes and other indicators for viewing an entity's label.

Trusted stripe – This stripe is a special graphical security mechanism. In Solaris Trusted Extensions (CDE), the trusted stripe is always displayed at the bottom of the screen. In Solaris Trusted Extensions (JDS), the stripe is displayed at the top of the screen.

Limited access to applications from the workspace – The workspace provides access only to those applications that are permitted in your account.

Trusted Path menu – In Trusted CDE, the switch area in the Front Panel provides access to the Trusted Path menu, which is used to perform security-related tasks. In Trusted JDS, the trusted symbol provides access to the menu.

Labels on Trusted Extensions Desktops

As discussed in "Mandatory Access Control" on page 18, all applications and files in Trusted Extensions have labels. Trusted Extensions displays labels in the following locations:

- Window label stripes above the window title bar
- Window icon label stripes under the minimized window
- Window label indicator in the trusted stripe
- Query window label indicator from the Trusted Path menu that displays the label of the window or icon that is specified by the pointer location
- In Trusted JDS, the color of the panels indicate the label of the workspace.

**FIGURE 4-2** Panels Indicating Workspaces at Different Labels in Trusted JDS

Figure 4–1 shows how labels display on a Trusted CDE desktop. Figure 1–5 shows how labels display on a Trusted JDS desktop. The Query Window Label menu item can be used to display the label of a window. For an illustration, see Figure 3–5.

**Trusted Stripe**

In Trusted CDE, the trusted stripe appears in a reserved area at the bottom of the screen in all Trusted Extensions sessions. In Trusted JDS, the trusted stripe appears at the top of the screen.

The purpose of the trusted stripe is to give you a visual confirmation that you are in a legitimate Trusted Extensions session. The stripe indicates when you are interacting with the trusted computing base (TCB). The stripe also displays the labels of your current workspace and current window. The trusted stripe cannot be moved or obscured by other windows or dialog boxes.

In Trusted CDE, the trusted stripe has two elements:

- **The trusted symbol** – Displays when the screen focus is security-related.
- **The window label** – Optional. Displays the label of the active window.
In Trusted JDS, the trusted stripe has two additional elements:

- **The current account name** – At the right of the trusted symbol, displays the name of the owner of new processes in the workspace. If the account is a role account, a hat icon precedes the role name.
- **Labeled windows** – Displays the labels of all windows in the workspace.

**Trusted Symbol**

Whenever you access any portion of the TCB, the trusted symbol appears at the left of the trusted stripe area. If your configuration suppresses labels, then the trusted symbol appears with the trusted stripe. In Trusted CDE, the symbol appears to the left of the Front Panel. In Trusted JDS, the symbol appears at the left of the trusted stripe.

The trusted symbol is not displayed when the pointer is focused in a window or area of the screen that does not affect security. The trusted symbol cannot be forged. If you see the symbol, you can be sure that you are safely interacting with the TCB.

**Caution** – If the trusted stripe is missing from your workspace, contact the **security administrator**. The problem with your system could be serious.

The trusted stripe should not appear during login, or when you lock your screen. If the trusted stripe shows, contact the administrator immediately.

**Window Label Indicator**

The **Window Label** indicator displays the label of the active window. In a multilevel session, the indicator can help identify windows with different labels in the same workspace. The indicator can also show that you are interacting with the TCB. For example, when you change your password, the Trusted Path indicator displays in the trusted stripe.
Device Security in Trusted Extensions

By default in Trusted Extensions, devices are protected by device allocation requirements. Users cannot use a device without being given explicit authorization to allocate devices, and an allocated device cannot be used by another user. A device in use at one label cannot be used at another label until it is deallocated from the first label and allocated at the second label.

To use a device, see "How to Allocate a Device in Trusted Extensions" on page 53.

Files and Applications in Trusted Extensions

All applications in Trusted Extensions have a level of sensitivity that is indicated by their label. Applications are subjects in any data transactions. Subjects must dominate the objects that the subjects try to access. Objects can be files and sometimes other processes can be objects. The label information for an application is displayed in the window label stripe. The label is visible when a window is open and when a window is minimized. An application’s label also appears in the trusted stripe when the pointer is in the application’s window.

In Trusted Extensions, files are objects in data transactions. Files can be accessed only by applications whose labels dominate the files’ labels. A file can be viewed from windows that have the same label as the file.

Some applications use initialization files to configure the environment for the user. Two special files in your home directory help you access initialization files at every label. These files enable an application at one label to use an initialization file that originates in a directory at a different label. The two special files are .copy_files and .link_files.

.copy_files File

The .copy_files file stores file names to be copied when you first change to a workspace with a higher label. This file is stored in your home directory at your minimum label. This file is useful when you have an application that always writes to a file in your home directory with a specific name. The .copy_files file enables you to specify that the application update the file at every label.
.link_files File

The .link_files file stores file names to be linked when you first change to a workspace with a higher label. This file is stored in your home directory at your minimum label. The .link_files file is useful when a specific file needs to be available at multiple labels, but the content must be identical at every label.

Password Security in the Solaris OS

Users who change passwords on a frequent basis shorten the window of opportunity for intruders to use illegally obtained passwords. Therefore, your site's security policy can require you to change your password regularly. The Solaris OS can set content requirements for passwords and enforce password resetting requirements. The following are possible resetting requirements:

- **Minimum number of days between changes** – Prevents you or anyone else from changing your password for a set number of days.
- **Maximum number of days between changes** – Requires you to change your password after a set number of days.
- **Maximum number of inactive days** – Locks your account after the set number of days of inactivity if the password has not been changed.
- **Expiration date** – Requires you to change your password by a specific date.

If your administrator has implemented one of the preceding options, you are sent an email message that warns you to change your password prior to the cutoff date.

Passwords can have content criteria. At minimum, passwords in the Solaris OS must meet the following criteria:

- The password must be at least eight characters long.
- The password must contain at least two alphabetic characters and at least one numeric character or one special character.
- The new password must differ from your previous password. You cannot use a reverse or circular shift of the previous password. For this comparison, uppercase letters and lowercase letters are considered to be equal.
- The new password must have at least three characters that are different from the old password. For this comparison, uppercase letters and lowercase letters are considered to be equal.
- The password must be difficult to guess. Do not use a common word or a proper name. Programs and individuals who try to break into an account can use lists to try to guess users’ passwords.
You can change your password by using the Change Password menu item from the Trusted Path menu. For the steps, see “Performing Trusted Actions” on page 51.

**Front Panel Security (Trusted CDE)**

The Front Panel in Solaris Trusted Extensions (CDE) is very similar to the Front Panel that is used in the standard CDE. The Trusted Extensions Front Panel restricts access to only those applications, files, and utilities that you are allowed to use. By clicking mouse button 3 anywhere in the workspace switch area, the Trusted Path menu is displayed.

Before you can access a device through the Removable Media Manager, that device must be allocated by using the Device Allocation Manager. The Device Allocation Manager is accessed from the Tools subpanel, which is above the Style Manager icon in the Front Panel.

**Tip** – If you minimize the Front Panel, you can restore the panel by clicking anywhere in the trusted stripe.

In Trusted Extensions, Install Icon drop sites are limited to the applications and files that you are permitted to use at the label of the current workspace.

For more information about the standard CDE, see the *Common Desktop Environment User’s Guide*.

**Workspace Switch Area**

In Trusted Extensions, the workspace buttons not only define separate workspaces, but they also require you to work at particular labels. When you begin a multilevel session, each workspace is set to the lowest label that you can use. If your administrator has color-coded the labels at your site, the workspace buttons display the color of the label. The Trusted Path menu is available from the workspace switch area.

**Trusted Path Menu**

The Trusted Path menu contains menu items that affect security, as the following figure shows.
For example, you change your password or allocate devices with this menu. For details, see “Performing Trusted Actions” on page 51.

In Trusted CDE, the Trusted Path menu has a second version. The Workspace Name version includes additional workspace options. The selections that appear in your menu depend on how the administrator configured your account.

Clock Security

In Trusted Extensions, only an administrator can change the date and time that is set for your workstation.

Calendar Security

The calendar shows the appointments for you at the label of your current workspace only. To view appointments at a different label, you need to open the calendar at that label.
File Manager Security

In Trusted Extensions, the File Manager displays files at the label of the current workspace. To view files at more than one label at a time, you run the File Manager from workspaces at different labels. You then use the Occupy Workspace command to display the different File Manager windows in the same workspace.

The File Manager enables you to change a file or folder’s basic permissions and access control list (ACL). If you are authorized, you can also move or link files between File Managers at different labels. For details about File Manager use, see “How to View Your Files in a Labeled Workspace” on page 44 and “Performing Trusted Actions” on page 51.

Text Editor Security

A text editor can be used to edit files at the label of the current workspace only. If you are authorized, you can copy information between text editors at different labels.

Personal Applications Subpanel

The default applications in the Personal Applications subpanel operate similarly to the standard CDE environment. The Terminal icon opens the default shell that is assigned to you by your administrator. To access a web server, the label of your browser must be the same as the label of the web server.

Mailer Security

In Trusted Extensions, all mail messages are labeled. When you send a message, it is sent at the label of your mail application. Only hosts and users that are cleared for that label receive the message. Only users who are working at that label can view the message.

If you need to use the vacation message option in your mail application, you must explicitly enable vacation message replies for each label at which you typically receive mail. Check with your security administrator for your site’s security policy on vacation messages.

Printer Security

The Print Manager in the Personal Printers subpanel displays icons for all printers that are accredited up to your clearance. However, you can use only those printers that are accredited to print documents at the label of the current workspace.
A typical print job in Trusted Extensions includes labels and extra pages, as follows:

- A banner page at the beginning of the print job identifies the print job, handling instructions, and labels that are appropriate to the site.
- Body pages are labeled at the header and the footer.
- A trailer page at the end of the print job signals the end of the job.

A typical banner page appears in the following figure. The words JOB START indicate the banner page.

For the exact security information regarding printing at your site, see your administrator.

**Style Manager Security**

With three exceptions, the Style Manager operates in the same manner as on a Solaris system.
- The Style Manager cannot be run from the Application Manager when Trusted Extensions is configured because the Style Manager requires the trusted path. Run the Style Manager from the Front Panel and the Workspace menu, where the Style Manager has the trusted path.

- The Screen Saver and Screen Lock options are limited. Your administrator specifies the maximum amount of time that your system can be idle prior to being locked. You can reduce the idle time. You cannot increase the idle time beyond the maximum. You can still choose a pattern for when the screen is locked. See your administrator if you are not familiar with the policy at your site.

- The Startup control sets your startup session settings according to the label or clearance that you specify at login. Thus, you can save a different workspace configuration for each label in your account label range.

**Application Manager Security**

The Application Manager provides access to only those applications and utilities that your administrator has assigned to you. In a role, you have access to a different set of applications and capabilities. Remember that the ability of a function to operate on a file depends on the label of the current workspace.

Similarly, although you can add applications to the Personal Application subpanel by dropping icons onto the Install Icon drop site, you can only run an application if your administrator has assigned the application to you.

**Trash Can Security**

In Trusted Extensions, the trash can stores files to be deleted by label. Although you can drop files at any label in the trash can, the trash can displays files at the current label only. You must delete sensitive information as soon as the information is in the trash can.

**Workspace Security (Trusted JDS)**

In Trusted Extensions, Trusted JDS provides equivalent security to Trusted CDE, but the look and feel is different. As in Trusted CDE, desktop applications are label-aware. Applications run at the label of the current workspace, and display information only at the label of the process that opened the application.
The location of security features differs in Trusted JDS from their location in Trusted CDE. The behavior can also be different.

- In Trusted JDS, the Trusted Path menu is available from the trusted stripe.
- The label name of a window in the task list on the panel appears in a tooltip when the mouse hovers over the window. Similarly, the label name of a workspace in the switch area appears in the tooltip.
- To change to a role, you click the account name in the trusted stripe and choose the role.
- To add a workspace at a particular label, you select an existing workspace and change its label.
- The desktop can be configured so that each workspace reflects the color of the label at which you are working in that workspace.
### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>access control list (ACL)</strong></td>
<td>A security feature of the Solaris OS. An ACL extends discretionary access control (DAC) to use a list of permission specifications (ACL entries) that apply to specific users and specific groups. An ACL allows finer-grained control than the control that standard UNIX permissions provides.</td>
</tr>
<tr>
<td><strong>access permission</strong></td>
<td>A security feature of most computer systems. Access permission gives the user the right to read, write, execute, or view the name of a file or directory. See also discretionary access control (DAC) and mandatory access control (MAC).</td>
</tr>
<tr>
<td><strong>account label range</strong></td>
<td>The set of labels that are assigned by the security administrator to a user or role for working on a system that is configured with Trusted Extensions. A label range is defined at the upper end by the user’s clearance and at the lower end by the user’s minimum label. The set is limited to well-formed labels.</td>
</tr>
<tr>
<td><strong>accreditation range</strong></td>
<td>A set of labels that are approved for a class of users or resources. See also system accreditation range, user accreditation range, label encodings file, and network accreditation range.</td>
</tr>
<tr>
<td><strong>action</strong></td>
<td>An application that can be accessed from the CDE (Common Desktop Environment) graphical user interface. An action is represented by an icon. The action consists of one or more commands and optional user prompts. In Trusted Extensions, an action is only available to a user if the security administrator has included the action in a rights profile that is assigned to the user’s account. Similarly, certain functions of the action might be available only if the security administrator has assigned the appropriate authorizations and privileges in that rights profile.</td>
</tr>
<tr>
<td><strong>administrative labels</strong></td>
<td>Two special labels intended for administrative files only: ADMIN_LOW and ADMIN_HIGH. ADMIN_LOW is the lowest label in the system with no compartments. This label is strictly dominated by all labels in the system. Information at ADMIN_LOW can be read by all but can only be written by a user in a role who is working at the ADMIN_LOW label. ADMIN_HIGH is the highest label in the system with all compartments. This label strictly dominates all labels in the system. Information at ADMIN_HIGH can only be read by users in roles that operate at ADMIN_HIGH. Administrative labels are used as labels or clearances for roles and systems. See also dominating label.</td>
</tr>
<tr>
<td><strong>allocatable device</strong></td>
<td>A security feature of the Solaris OS. An allocatable device can be used by one user at a time, and is capable of importing or exporting data from the system. The security administrator determines which users are authorized to access which allocatable devices. Allocatable devices include tape drives, floppy drives, audio devices, and CD-ROM devices. See also device allocation.</td>
</tr>
<tr>
<td><strong>audit ID (AUID)</strong></td>
<td>A security feature of the Solaris OS. An audit ID represents the login user. The AUID is unchanged after the user assumes a role, so is used to identify the user for auditing purposes. The audit ID always represents the user for auditing even when the user acquires effective UIDs/GIDs. See also user ID (UID).</td>
</tr>
</tbody>
</table>
**auditing**  
A security feature of the Solaris OS. Auditing is a process for capturing user activity and other events on the system, then storing this information in a set of files that is called an *audit trail*. Auditing produces system activity reports to fulfill site security policy.

**authorization**  
A security feature of the Solaris OS. An authorization grants permission to a user to perform an action that is otherwise prohibited by security policy. The *security administrator* assigns authorizations to *rights profiles*. Rights profiles are then assigned to user or *role* accounts. Some commands and actions do not function fully unless the user has the necessary authorizations. See also *privilege*.

**classification**  
A component of a *clearance* or a *label*. A classification indicates a hierarchical level of security, for example, TOP SECRET or UNCLASSIFIED.

**clearance**  
A label that defines the upper boundary of a *label range*. A clearance has two components: a *classification* and zero or more *compartments*. A clearance does not need to be a *well-formed label*. A clearance defines a theoretical boundary, not necessarily an actual label. See also *user clearance*, *session clearance*, and *label encodings file*.

**Common Desktop Environment (CDE)**  
A labeled graphical desktop that includes a session manager, a window manager, and various desktop tools. Trusted Extensions adds trusted applications to the desktop, such as the *label builder*, *Device Allocation Manager*, and *Selection Manager*. See also *Trusted JDS*.

**compartment**  
A nonhierarchical component of a *label* that is used with the *classification* component to form a *clearance* or a *label*. A compartment represents a group of users with a potential need to access this information, such as an engineering department or a multidisciplinary project team.

**compartmented mode workstation (CMW)**  
A computing system that fulfills the government requirements for a trusted workstation as stated in *Security Requirements for System High and Compartmented Mode Workstations*, DIA document number DDS-2600-5502-87. Specifically, it defines a trusted, X Window System-based operating system for UNIX workstations.

**covert channel**  
A communication channel that is not normally intended for data communication. A covert channel allows a process to transfer information indirectly in a manner that violates the intent of the security policy.

**deallocated device**  
A security feature of the Solaris OS. A deallocated device is no longer allocated to a user for exclusive use. See also *device allocation*.

**device**  
See *allocatable device*.

**device allocation**  
A security feature of the Solaris OS. Device allocation is a mechanism for protecting the information on an *allocatable device* from access by anyone except the user who allocates the device. When the device is deallocated, device clean scripts are run to clean information from the device before the device can be accessed again by another user. In Trusted Extensions, device allocation is handled by the *Device Allocation Manager*.

**Device Allocation Manager**  
A trusted application of Trusted Extensions. This GUI is used to configure devices, and to allocate and deallocate devices. Device configuration includes adding authorization requirements to a device.
discretionary access control (DAC)  An access control mechanism that allows the owner of a file or directory to grant or deny access to other users. The owner assigns read, write, and execute permissions to the owner, the user group to which the owner belongs, and a category called other, which refers to all other unspecified users. The owner can also specify an access control list (ACL). An ACL lets the owner assign permissions specifically to additional users and additional groups. Contrast with mandatory access control (MAC).

disjoint label  See dominating label.

dominating label  In a comparison of two labels, the label whose classification component is higher than or equal to the second label's classification and whose compartment components include all of the second label's compartment components. If the components are the same, the labels are said to dominate each other and are equal. If one label dominates the other and the labels are not equal, the first label is said to strictly dominate the other. Two labels are disjoint if they are not equal and neither label is dominant.

downgraded label  A label of an object that has been changed to a value that does not dominate the previous value of the label.

effective UIDs/GIDs  A security feature of the Solaris OS. Effective IDs override a real ID when necessary to run a particular program or an option of a program. The security administrator assigns an effective UID to a command or action in a rights profile when that command or action must be run by a specific user, most often when the command must be run as root. Effective group IDs are used in the same fashion. Note that the use of the setuid command as in conventional UNIX systems might not work due to the need for privileges.

evaluatable configuration  A computer system that meets a set standard of government security requirements. See also extended configuration.

extended configuration  A computer system that is no longer an evaluatable configuration due to modifications that have broken security policy.

fallback mechanism  A shortcut method for specifying IP addresses in the tnrhtp database. For IPv4 addresses, the fallback mechanism recognizes 0 as a wildcard for a subnet.

gateway  A host that has more than one network interface. Such a host can be used to connect two or more networks. When the gateway is a Trusted Extensions host, the gateway can restrict traffic to a particular label.

group ID (GID)  A security feature of the Solaris OS. A GID is an integer that identifies a group of users who have common access permissions. See also discretionary access control (DAC).

host  A computer attached to a network.

host template  A record in the tnrhtp database that defines the security attributes of a class of hosts that can access the Trusted Extensions network.

host type  A classification of a host. The classification is used for network communications. The definitions of host types are stored in the tnrhtp database. The host type determines whether the CIPSOnetwork protocol is used to communicate with other hosts on the network. Network protocol refers to the rules for packaging communication information.
label

Label

Also referred to as a sensitivity label. A label indicates the security level of an entity. An entity is a file, directory, process, device, or network interface. The label of an entity is used to determine whether access should be permitted in a particular transaction. Labels have two components: a classification that indicates the hierarchical level of security, and zero or more compartments for defining who can access the entity at a given classification. See also label encodings file.

label builder

A trusted application of Trusted Extensions. This GUI enables users to choose a session clearance or a session label. The clearance or label must be within the account label range that the security administrator has assigned to the user.

label encodings file

A file that is managed by the security administrator. The encodings file contains the definitions for all valid clearances and labels. The file also defines the system accreditation range, user accreditation range, and defines the security information on printouts at the site.

label range

Any set of labels that are bounded on the upper end by a clearance or maximum label, on the lower end by a minimum label, and that consist of well-formed labels. Label ranges are used to enforce mandatory access control (MAC). See also label encodings file, account label range, accreditation range, network accreditation range, session range, system accreditation range, and user accreditation range.

label view

A security feature that displays the administrative labels or substitutes unclassified placeholders for the administrative labels. For example, if security policy forbids exposing the labels ADMIN_HIGH and ADMIN_LOW, the labels RESTRICTED and PUBLIC can be substituted.

labeled workspace

A Solaris Trusted Extensions (CDE) or a Solaris Trusted Extensions (JDS) workspace. A labeled workspace labels every activity that is launched from the workspace with the label of the workspace. When users move a window into a workspace of a different label, the moved window retains its original label.

least privilege

See principle of least privilege.

mandatory access control (MAC)

A system-enforced access control mechanism that uses clearances and labels to enforce security policy. A clearance or a label is a security level. MAC associates the programs that a user runs with the security level at which the user chooses to work in the session. MAC then permits access to information, programs, and devices at the same or lower level only. MAC also prevents users from writing to files at lower levels. MAC cannot be overridden without special authorizations or privileges. Contrast with discretionary access control (DAC).

minimum label

A label that is assigned to a user as the lower bound of the set of labels at which that user can work. When a user first begins a Trusted Extensions session, the minimum label is the user's default label. At login, the user can choose a different label for the initial label.

Also, the lowest label that is permitted to any non-administrative user. The minimum label is assigned by the security administrator and defines the bottom of the user accreditation range.

network accreditation range

The set of labels within which Trusted Extensions hosts are permitted to communicate on a network. The set can be a list of four discrete labels.

object

A passive entity that contains or receives data, such as a data file, directory, printer, or other device. An object is acted upon by subjects. In some cases, a process can be an object, such as when you send a signal to a process.
operator  A role that can be assigned to the user or users who are responsible for backing up systems.

ordinary user  A user who holds no special authorizations that allow exceptions from the standard security policies of the system. Typically, an ordinary user cannot assume an administrative role.

permissions  A set of codes that indicate which users are allowed to read, write, or execute the file or directory (folder). Users are classified as owner, group (the owner’s group), and other (everyone else). Read permission (indicated by r) lets the user read the contents of a file or, if a directory, list the files in the folder. Write permission (w) lets the user make changes to a file or, if a folder, add or delete files. Execute permission (e) lets the user run the file if the file is executable. If the file is a directory, execute permission lets the user read or search the files in the directory. Also referred to as UNIX permissions or permission bits.

principle of least privilege  The security principle that restricts users to only those functions that are necessary to perform their jobs. The principle is applied in the Solaris OS by making privileges available to programs on an as-needed basis. Privileges are available on an as-needed basis for specific purposes only.

privilege  A security feature of the Solaris OS. A privilege is a permission that is granted to a program by the security administrator. A privilege can be required to override some aspect of security policy. See also authorization.

privileged process  A security feature of the Solaris OS. A privileged process runs with assigned has privileges.

process  A running program. Trusted Extensions processes have Solaris security attributes, such as user ID (UID), group ID (GID), the user's audit ID (AUID), and privileges. Trusted Extensions adds a label to every process.

profile See rights profile.

profile shell  A security feature of the Solaris OS. A version of the Bourne shell that enables a user to run programs with security attributes.

reading down  The ability of a subject to view an object whose label the subject dominates. Security policy generally allows reading down. For example, a text editor program that runs at Secret can read Unclassified data. See also mandatory access control (MAC).

rights profile  A security feature of the Solaris OS. A rights profile enables a site’s security administrator to bundle commands and CDE actions with security attributes. Attributes such as user authorizations and privileges enable the commands and actions to succeed. A rights profile generally contains related tasks. A profile can be assigned to users and to roles.

role  A security feature of the Solaris OS. A role is a special account that gives the user who assumes the role access to certain applications with the security attributes that are necessary for performing the specific tasks.

security administrator  On system that is configured with Trusted Extensions, the role that is assigned to the user or users who are responsible for defining and for enforcing security policy. The security administrator can work at any label in the system accreditation range, and potentially has access to all information at the site. The security administrator configures the security attributes for all users and equipment. See also label encodings file.
security attribute

A security feature of the Solaris OS. A property of an entity, such as a process, zone, user, or device, that is related to security. Security attributes include identification values such as user ID (UID) and group ID (GID). Attributes that are specific to Trusted Extensions include labels and label ranges. Note that only certain security attributes apply to a particular type of entity.

security policy

The set of DAC, MAC, and label rules that define how information can be accessed and by whom. At a customer site, the set of rules that defines the sensitivity of the information that is processed at that site. Policy includes the measures that are used to protect the information from unauthorized access.

Selection Manager

A trusted application of Trusted Extensions. This GUI appears when authorized users attempt to upgrade information or downgrade information.

effectivity label

See label.

session

The time between logging in to a Trusted Extensions host and logging out from the host. The trusted stripe appears in all Trusted Extensions sessions to confirm that users are not being spoofed by a counterfeit system.

session clearance

A clearance set at login that defines the upper boundary of labels for a Trusted Extensions session. If the user is permitted to set the session clearance, the user can specify any value within the user’s account label range. If the user’s account is configured for forced single-level sessions, the session clearance is set to the default value specified by the security administrator. See also clearance.

session range

The set of labels that are available to a user during a Trusted Extensions session. The session range is bounded at the upper boundary by the user’s session clearance and at the lower end by the minimum label.

single-label configuration

A user account that has been configured for operation at a single label only. Also called a single-level configuration.

spoof

To counterfeit a software program in order to illegally get access to information on a system.

strict dominance

See dominating label.

subject

An active entity, usually a process that runs on behalf of a user or role. A subject causes information to flow among objects, or changes the system state.

system accreditation range

The set of all valid labels for a site. The set includes the administrative labels that are available to the site’s security administrator and system administrator. The system accreditation range is defined in the label encodings file.

system administrator

A security feature of the Solaris OS. The System Administrator role can be assigned to the user or users who are responsible for performing standard system management tasks such as setting up the non-security-relevant portions of user accounts. See also security administrator.

trusted application

An application that has been granted one or more privileges.

trusted computing base (TCB)

The part of a system that is configured with Trusted Extensions that affects security. The TCB includes software, hardware, firmware, documentation, and administrative procedures. Utility programs and application programs that can access security-related files are all part of the trusted computing base.
<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>trusted facilities management</td>
<td>All activities associated with system administration in a conventional UNIX system, plus all of the administrative activities that are necessary to maintain the security of a distributed system and the data that the system contains.</td>
</tr>
<tr>
<td>Trusted JDS</td>
<td>A labeled graphical desktop that includes a session manager, a window manager, and various desktop tools. Trusted JDS is a fully accessible desktop.</td>
</tr>
<tr>
<td>trusted path</td>
<td>Refers to the mechanism for accessing actions and commands that are permitted to interact with the trusted computing base (TCB). See also Trusted Path menu, trusted symbol, and trusted stripe.</td>
</tr>
<tr>
<td>Trusted Path menu</td>
<td>A menu of Trusted Extensions operations that is displayed by holding down mouse button 3 over the switch area of the Front Panel. The menu selections fall into three categories: workspace-oriented selections, role assumption selections, and security-related tasks.</td>
</tr>
<tr>
<td>trusted stripe</td>
<td>A screen-wide rectangular graphic in a reserved area of the screen. The trusted stripe appears in all Trusted Extensions sessions to confirm valid Trusted Extensions sessions. Depending on a site's configuration, the trusted stripe has one or two components: (1) a mandatory trusted symbol to indicate interaction with the trusted computing base (TCB), and (2) an optional label to indicate the label of the current window or workspace.</td>
</tr>
<tr>
<td>trusted symbol</td>
<td>The symbol that appears at the left of the trusted stripe area. The symbol is displayed whenever the user accesses any portion of the trusted computing base (TCB).</td>
</tr>
<tr>
<td>upgraded label</td>
<td>A label of an object that has been changed to a value that dominates the previous value of the label.</td>
</tr>
<tr>
<td>user accreditation range</td>
<td>The largest set of labels that the security administrator can potentially assign to a user at a specific site. The user accreditation range excludes the administrative labels and any label combinations that are available to administrators only. The user accreditation range is defined in the label encodings file.</td>
</tr>
<tr>
<td>user clearance</td>
<td>A clearance that is assigned by the security administrator. A user clearance defines the upper boundary of a user's account label range. The user's clearance determines the highest label at which the user is permitted to work. See also clearance and session clearance.</td>
</tr>
<tr>
<td>user ID (UID)</td>
<td>A security feature of the Solaris OS. A UID identifies a user for the purposes of discretionary access control (DAC), mandatory access control (MAC), and auditing. See also access permissions.</td>
</tr>
<tr>
<td>well-formed label</td>
<td>A label that can be included in a range, because the label is permitted by all applicable rules in the label encodings file.</td>
</tr>
<tr>
<td>workspace</td>
<td>See labeled workspace.</td>
</tr>
</tbody>
</table>
Index

A
access control
  access control lists (ACLs), 18
  discretionary access control (DAC), 18
  mandatory access control (MAC), 18-24
  permission bits, 18
access control lists (ACLs), 18
accessibility, provided by Trusted JDS, 31
accessing
  for readonly, 23
  for reading and writing, 23
  for writing, 23
  initialization files at every label, 47-48
  lower-level home directories, 22
  man pages in Trusted Extensions, 45
  remote multilevel desktop, 37-38
adding
  labeled workspace, 58-59
  workspaces, 58-59
admin role, See System Administrator role
Allocate Device menu item, 53-56
allocating, removable media, 55
allocating a device, 53-56
  troubleshooting, 56
Application Manager security in Trusted Extensions, 79
Assume rolename role menu item, 57
assuming a role, 57
authorizations
  changing labels, 24
  for allocating devices, 17
  required to change label of data, 61-64

C
calendar security in Trusted Extensions, 76
CDE, trusted applications on Front Panel, 75
Change Password menu item, 51-52
Change Workspace Label menu item, 58
changing
  labels by authorized users, 64-68
  security level of data, 61-64, 64-68
  workspace label, 58
  your password, 51-52
changing labels, troubleshooting, 68
choosing
  a desktop, 32, 33
  label or clearance during login, 35
classification component of label, defined, 18
clearances
  label type, 19
  setting at login, 25, 36
  setting session, 36
clock security in Trusted Extensions, 76
compartment component of label, defined, 19
customizing
  desktop, 50
containers, See zones
copy-and-paste, effect on labels, 24
.copy_files file
  creating, 47-48
  described, 73
  troubleshooting, 48
creating
  $HOME/.copy_files file, 47-48
  $HOME/.link_files file, 47-48
customizing
  desktop, 50
Index

customizing (Continued)
  Workspace Menu, 46-47

D
data
  changing label of, 61-64
  determining label of, 61
  protecting with MAC, 18-24
deallocating devices, basic procedure, 57
desktops
  common tasks, 50-51
  in Trusted Extensions, 31
  keyboard focus, 51-52
  logging in remotely, 37-38
determining
  label of a file, 61
  label of a window, 49
Device Allocation Manager, deallocating devices, 57
devices
  allocating, 53-56
  clearing prior to reuse, 27
  protecting, 17
  secured by allocation requirement, 73
  troubleshooting, 56
  using, 53-56
  using removable media, 55
directories
  changing labels, 64-68
  visibility of home directories, 22
discretionary access control (DAC), defined, 18
dominance between labels, 22-24
downgrading information, 24
drag-and-drop, effect on labels, 24

E
e-mail, label enforcement, 27
e-mail instructions, user responsibilities, 25

F
failsafe login, 37
File Browser
  displaying label of file, 61
  troubleshooting when it does not appear, 56
  viewing contents, 44, 45
File Manager
  changing file labels, 68
  changing labels, 64-68
  security in Trusted Extensions, 77
  troubleshooting when it does not appear, 56
  viewing contents, 44
files
  $HOME/.copy_files, 47-48, 73
  $HOME/.link_files, 47-48, 74
  accessing initialization files at every label, 47-48
  changing labels, 64-68
  linking between File Managers at different labels, 68
  moving between File Managers, 64-68
  viewing in a workspace, 44-45
finding
  calendar events at every label, 50
  online help for Trusted Extensions, 45-46
  Trusted Path menu, 57, 70
Front Panel
  description of trusted applications on, 75
  restoring when minimized, 75

H
help in Trusted Extensions
  man pages, 45
  online help, 45-46
home directories, visible from higher-level zone, 22
hot key, regaining control of desktop focus, 51-52

I
information, See data
initialization files
  accessing at every label, 47-48
  troubleshooting when customized, 37
K
key combinations, testing if grab is trusted, 51-52

L
label ranges
   described, 19
   troubleshooting a workstation with a restricted range, 37
labels
   See also clearances
   changing label of data, 61-64
   changing label of files, 64-68
   changing label on information, 24
   components, 18-20
   determining by window query, 49
   displayed in Trusted Extensions, 70-71
   displayed on desktop, 19, 20
   dominance, 22-24
   labeled zones, 21-22
   means of protecting data, 25-27
   ranges, 19
   relationships, 22-24
   sample government labels, 23
   sample industry labels, 19
   sample label relationships, 23
   setting at login, 36
   setting clearance at login, 25
   setting session labels, 36
   types, 19
   visible on desktop, 39
   .link_files file
   creating, 47-48
   described, 74
   troubleshooting, 48
   linking files at different labels, 68
      by using .link_files, 47-48
logging in
   at a different label, 52
   choosing a desktop, 32, 33
   choosing a label or clearance, 35
   failsafe, 37
   five steps of, 32
   remotely to multilevel desktop, 37-38
   (Continued)
      reviewing security settings, 34-36
      troubleshooting, 34, 37
logging out
   procedure, 42
   user responsibilities, 40
login process, See logging in

M
mail security in Trusted Extensions, 77
Main Menu, Shut Down, 43-44
man pages in Trusted Extensions, 45
mandatory access control (MAC)
   defined, 18-24
   enforced for email, 27
mounting, removable media, 55
moving
   a window to a workspace at a different label, 60-61
   data to different label, 61-64
   file to different label, 64-68
multiheaded system, trusted stripe, 39
multilevel login
   remote, 37-38
   Trusted CDE or Trusted JDS, 33
multilevel sessions, defined, 25

N
no trusted indicator, troubleshooting, 72
no trusted stripe, troubleshooting, 40
Not Found error message, 28
Not in Profile error message, 28

O
object
   defined, 19
   reuse, 27
oper role, See Operator role
Operator role, responsibilities, 29
Index

P
passwords, user responsibilities, 74-75
peripheral devices, See devices
permissions
   at discretion of file owner, 18
   user responsibilities, 24
pfsh command, See profile shell
policy, See security policy
Printer tool security in Trusted Extensions, 77-78
printing, typical labeled banner page, 78
procedures, See users
profile shell, defined, 28
profiles, See rights profiles
protecting files
   by label, 25-27
   DAC, 18
   MAC, 18-24
   user responsibilities, 24

Q
Query Window Label menu item, 49

R
read access, in labeled environment, 23
remote login, to multilevel desktop, 37-38
responsibilities
   of administrators, 29
   users for password security, 74-75
   users to clear media, 27
   users to protect data, 24-25
   users when logging out, 42
reviewing security settings
   Last Login dialog box, 33
   procedure during login, 34-36
rights profiles, defined, 28-29
roles
   adding a labeled workspace, 58-59
   changing workspace label, 58
   common roles, 29
   responsibilities of, 29
   special user account, 27-29
root role, responsibilities, 29

S
secadmin role, See Security Administrator role
Security Administrator role
   contacting about missing trusted indicator, 72
   contacting about missing trusted stripe, 40
   responsibilities, 29
security policy
   defined, 16, 86
security practices, defined, 16
selection, changing label, 61-64
Selection Manager, 63
sensitivity labels
   See labels
   label type, 19
session clearances, defined, 25
sessions
   choosing clearance, 25
   effect of selecting level, 25-26
   setting level, 36
   single-level or multilevel, 25
Shut Down menu item, 43-44
shutting down a workstation, 43-44
single-level login, Trusted CDE or Trusted JDS, 33
single-level sessions, defined, 25
Solaris Trusted Extensions (CDE), See CDE
spoofing
   defined, 17, 86
Stop-A (L1-A) keyboard combination, 43
Style Manager
   changing session characteristics, 52
   limitations in Solaris Trusted Extensions (CDE), 78-79
   requires the trusted path, 51
subject, defined, 19
Suspend System menu item, 43-44
switching to a workspace at a different label, 59-60
system administration, on Trusted Extensions, 27-29
System Administrator role, responsibilities, 29
T

tasks, See users
Text Editor security in Trusted Extensions, 77
Trash Can security in Trusted Extensions, 79
troubleshooting
$HOME/.copy_files file, 48
$HOME/.link_files file, 48
device allocation, 56
File Manager not appearing, 56
login, 37
minimized Front Panel, 75
missing trusted indicator, 72
missing trusted stripe, 40
password failure, 34
relabeling files, 68
trusted applications
by using rights profiles, 28-29
on Front Panel, 75
Trusted CDE
choosing as desktop, 33
customizing the desktop, 50
customizing the Workspace Menu, 46-47
finding online help for Trusted Extensions, 45
Trusted Extensions desktop, 31
using the Style Manager, 51
trusted computing base (TCB)
defined, 16
procedures that interact with the TCB, 51-68
symbol of interacting with, 17, 72
Trusted Extensions
overview, 15-16
visible features, 69-72
trusted grab, key combination, 51-52
trusted indicator, missing, 72
Trusted JDS
choosing as desktop, 33
customizing the desktop, 50
online help, 46
Trusted Extensions desktop, 31
workspace security, 79-80
Trusted Path menu
Allocate Device, 53-56
Assume rolename role, 57
Trusted Path menu (Continued)
Change Password, 51-52
Change Workspace Label, 58
described, 75-76
location, 70
Query Window Label, 49
using, 46
trusted stripe
described, 71
location in CDE, 70
location in Trusted JDS, 70
location on screen, 19, 20
not on lockscreen, 41
on multiheaded system, 39
what to do if missing, 40
trusted symbol
described, 72
on workspace, 39
tamper-proof icon, 17
types of labels, 19

U

unlabeled screens
lockscreen, 41
login screen, 31
upgrading information, 24
user clearances, defined, 19
user responsibilities
password security, 74-75
protecting data, 24-25
when leaving workstation, 40
users
accessing initialization files at every label, 47-48
adding a labeled workspace, 58-59
allocating a device, 53-56
assuming a role, 57
authorized to change label of file, 64-68
authorized to change security level of data, 61-64
changing workspace label, 58
changing your password, 51-52
customizing the Workspace Menu, 46-47
determining the label of a file, 61
finding online help for Trusted Extensions, 45-46
Index

users (Continued)
getting online help, 45
linking files at different labels, 68
locking your screen, 40-42
logging in at a different label, 52
logging out, 42
moving a window to a workspace at a different label, 60-61
moving data between labels, 61-64
moving files between labels, 64-68
responsibilities
  clearing devices, 27
  password security, 74-75
  protecting data, 24-25
  when leaving workstation, 42
shutting down a workstation, 43-44
switching to a workspace at a different label, 59-60
unlocking your screen, 41
viewing files in a workspace, 44-45
using a device, See allocating a device
using trusted desktop, single-level or multilevel, 33

V
visibility
  desktop security, 39-40
  labels after login, 31
  reading lower-level home directories, 22
  trusted stripe, 19, 20, 40, 70

W
Window Label indicator, 72
Workspace Menu
  customizing, 46-47
  Suspend System, 43-44
workspace switch area
  illustration, 26
  in Trusted Extensions CDE, 75
workspaces
  labeled, 26-27
  setting default label, 52
write access, in labeled environment, 23

Z
zones
  home directory visibility, 22
  labeled, 21-22